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To the reader

This book contains the information you need to understand and run this application. The information in this 
book applies only to Infor ERP XA, which is refered to as XA in this document.

For a complete list of books in the XA library, see the bibliography included on the XA documentation CD.

Before you begin

If you are not familiar with the System i, please complete the System ieducation for the basic operating 
concepts of the System i.

What this book contains

This book contains information about the design of Advanced Planner. 
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Chapter 1.   Installing and configuring the AVP application

This chapter describes how to install and configure the Advanced Planner (AVP) 
application 

System requirements for the AVP engine................................................................. 1-1
Installing AVP ........................................................................................................... 1-3
Configuring AVP ....................................................................................................... 1-5
Maintaining your installation ..................................................................................... 1-7
Planning multiple warehouses.................................................................................. 1-8

System requirements for the AVP engine

Table   1-1.  Plant size   

# of A B C D
Items <5,000 <20,000 <50,000 >50,000 
BOM <20,000 <20,000 <50,000 < 50,000
Routes <10,000 <20,000 <50,000 >50,000
Sales <1,000 <5,000 <10,000 <10,000
Fcst <1,000 <5,000 <10,000 >10,000

Table   1-2.  Plant size A system requirements   

Prerequisite Requirements
CPU Intel Pentium II 200MHz and greater; 

or equivalent AMD processor-based 
PC

Hard disk 2 GB free
RAM 128 MB
Operating 
system

Windows 2000 Professional Server

Table   1-3.  Plant size B system requirements   

Prerequisite Requirements
CPU Intel Pentium III 700 MHZ and 

greater; or equivalent AMD 
processor-based PC

Hard disk 5 GB free
RAM 256 MB
Operating 
system

Windows 2000 Professional Serve
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Note: These values are aggressive in nature. Actual performance may vary due to 
other software running on the system. XA makes no explicit recommendations as to 
the guarantee of this data. You should always have sufficient memory in order to allow 
the AVP engine to perform. A simple rule is, despite the size of your plant, to use the 
memory requirements for one plant-size larger than yours. For example, if your 
company is plant size B, have 512 MB RAM available. 

System i connectivity

The desktop running the Advanced Planner engine must be connected by an Open 
Database Connection (ODBC) data source to the System i server running XA. Use 
Client Access Express, Version 5, Release 1 or later for this connection. 

AVP engine database

The Advanced Planner engine uses a Microsoft Access 2000 database, shipped in 
the Db folder in the AVP install folder, and an ODBC data source named MAPICS 
Advanced Planner 6.0 pointed to it. Microsoft Access 2000 need not be installed on 
the PC to run the AVP engine. 

Table   1-4.  Plant size C system requirements   

Prerequisite Requirements
CPU Best in class Pentium IV; or PC from 

known brands such as Dell, Compaq, 
Gateway, or Micron

Hard disk 5 GB free
RAM 512 MB
Operating 
system

Windows 2000 Professional Server

Table   1-5.  Plant size D system requirements   

Prerequisite Requirements
CPU Best in class Pentium IV; or PC from 

known brands such as Dell, Compaq, 
Gateway, or Micron

Hard disk 5 GB free
RAM 1 to 2 GB
Operating 
system

Windows 2000 Professional Server
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Installing AVP

Advanced Planner (AVP) includes the Advanced Planner engine and Material 
Requirements Planning (MRP).The prerequisites for MRP include the following XA 
applications: 

• Cross Application Support (CAS)
• Inventory Management (IM)
• Either Product Data Management (PDM) or Enterprise Product Data 

Management (EPDM). 

Install MRP using the normal XA installation process. To install the Advanced Planner 
engine, double-click on the MAPSetup.exe from an Explorer directory. The installation 
process begins. The following window appears: 

You can accept the default directory or click Browse ... to select another directory. 
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You can also click Back to return to the previous display or click Cancel to cancel the 
installation process. If you click Next, the following window appears. 

Click Finish to complete the installation process. Now, Advanced Planner appears on 
your Start/Programs menu. 

You can also click Back to return to the previous display or click Cancel to cancel the 
installation. If you click Finish, a status window appears. Once the installation is 
complete, the following display appears: 
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Click Finish to complete the installation. Two other buttons, Back and Cancel, 
appear but are greyed out. 

Configuring AVP

Configuring AVP includes the following: 

• Creating an Open Database Connection (ODBC) data source to the System i 
server running XA

• Linking the AVP engine to the XA environment through that data source

• Setting parameters for AVP planning

Creating an ODBC data source

This section helps you establish an ODBC connection between your Windows 
desktop and the System i on which XA is installed. Ensure that you have Client 
Access on your Windows desktop. 

Start Advanced Planner. Select File > System Configuration. The following window 
appears: 

Select Setup. Then select ODBC Setup. The ODBC Data Source Administrator 
window appears. Then do the following: 

1. Select the System DSN Tab and click the Add button. 
2. The Create New Data Source window appears. Select Client Access ODBC 

Driver. Then click Finish. 
3. The Client Access Express Data Source ODBC Setup window appears. Do the 

following:

a. From the General tab, type a DSN name in the Data Source Name field and 
select the appropriate server from the System i list. Select Connection 
Options. In the Default user ID section, select Use the user ID specified 
below, and type in the user ID. Click OK. 

b. Select the Server tab. Select System naming Convention (*SYS) in the 
Naming convention field. Type in AMALIBx in the SQL default library field, 
where X is the first character of the XA environment ID. Type in QGPL in the 
Library list field. 
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c. Select the Translation tab. Select Convert binary data (CCSID 65535) to text. 
Click on OK.

Warning: Failure to set translate to this option will result in unreadable files. 

d. Click OK two more times to create the data source and return to the System 
Configuration window. 

Linking AVP to the XA environment on the System i

Navigate to the MAPICSADVPLAN folder on the drive on which you installed 
Advanced Planner. Edit the APDataLink.ini file in that folder to identify the data 
source, the user ID and password, the environment, and the warehouse. See the 
sample file that follows. Other elements in this file are explained in later sections in the 
document. 

DataSourceName The DSN you gave the ODBC data source you created in the 
preceding steps. 

UserID A valid user ID in the XA environment

Password The password for the XA user ID

Env (Environment) The two-character XA environment ID 

Warehouse The three-character warehouse ID

[ODBC]
DataSourceName=AP60
UserId=SCM
Password=SCM
[Download]
Env=66
Warehouse=TP6
DownLoad=0
LoadItem=0
PrintReport=1
Hours=0000008
[Upload]
COMPromiseDate=0
COMDueDate=0
[Download Files]
InputFileDir=C:\MAPICSADVPLAN\SampleDBAP\
CommaSeparated=0
ShowColumnHeader=0
Delimiter=
[Debug]
DebugDesign=0
DebugUpload=0
[System]
AVPActive=0
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Setting parameters for AVP planning

You can specify the following: 

• The number of days to include in the load calculations
• Whether or not to include setup in the load calculations.

Start Advanced Planner. Select File > System Configuration. The System 
Configuration window appears. 

Default Horizon in Days
Type in the number of days in the horizon for load to capacity (L:C) planning. The 
scheduling horizon starts with the MRP current date, and loads and capacities are 
calculated over this horizon. The supply plan covers all demand, regardless of 
this horizon. Default is 30 days.

Include Setup in L:C
Check this box to adjust the load to capacity chart for setup. If you select this 
option, setup is included for every supply order run on the facility.

Maintaining your installation

Periodically, AVP updates will be made available to you. Do the following: 

1. Download the software

2. Uninstall the existing AVP program by selecting Start > Programs > Uninstall 
Advanced Planner 6.0. 

3. Install the new version. See “Installing AVP” for more information.  

4. If you renamed one or both Advanced Planner desktop icons, installing a new 
version may create new icons with the original name. If so, delete these new 
icons. 

Your original configuration information is maintained; therefore, you need perform no 
other steps. 
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Planning multiple warehouses

To plan multiple warehouses with AVP, install the AVP engine for each warehouse 
because each warehouse requires separate:

• PC database
• ODBC connection to that database
• ODBC connection to the XA on the System i.

You can either plan each warehouse on a separate PC or you can plan multiple 
warehouses on the same PC.

• To plan each warehouse on a separate PC, use the preceding sections of this 
chapter to install and configure the AVP engine on each PC planning a 
warehouse.

• To plan multiple warehouses on one PC, use the following sections to install the 
AVP engine multiple times on the PC.

Multiple AVP installations on one PC

Ensure you have sufficient disk space to contain each installation and sufficient RAM 
for the applications running on the PC. For example, to simultaneously plan multiple 
warehouses, you must have twice the RAM figure in the quoted system requirements 
section. See “System requirements for the AVP engine” for more information.  

First, install and configure the AVP engine for an XA environment and warehouse, as 
described in this chapter. To prepare for the second installation, do the following:

1. Rename the Advanced Planner Download desktop icon. For example, rename it 
to AVP DL WH1, where WH1 is the ID of the warehouse in the first installation. 

2. Rename the Advanced Planner desktop icon. For example, rename it to AVP 
WH1, where WH1 is the ID of the warehouse in the first installation. 

3. Rename the ODBC connection to the AVP Access database: 

a. Start Advanced Planner. Select File > System Configuration. In the System 
Configuration window, select Setup. In the Dialog window, select ODBC 
Setup. The ODBC Data Source Administrator window appears. 
Select the System DSN tab. Double click on the Data Source named 
Advanced Planner 6.0. The ODBC Microsoft Access Setup window appears. 
Rename the data source:

1) Type a new name over the existing name, Advanced Planner 6.0. For 
example, type AVP WH1 where WH1 is the ID of the warehouse in the 
first installation. 

2) Click OK, then OK again. In the Dialog window, ensure that your newly 
renamed data source is selected in the Select ODBC Source list. Click 
OK, then OK again. Exit Advanced Planner. 

b. Navigate to the folder in which you installed AVP (MAPICSADVPLAN, if you 
accepted the default). Edit the Config.ini file. Replace the name of the data 
source (DataSourceName) with the new name you assigned in the preceding 
steps. For example, type in AVP WH1.

You are now ready to install AVP for the second warehouse. See “Installing AVP” for 
more information.   See “Configuring AVP” for more information.  Do the following: 
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1. Install the AVP engine in a separate folder. Select Browse… on the Select 
Destination Directory window and typing in a different folder name. For example, 
type in AVP WH2, where WH2 is the ID of the second warehouse. The folder can 
be on the same drive as the first installation or on a different drive. See 
“Configuring AVP” for more information.  

2. Create a new ODBC data source to the System i server, to permit concurrent 
operation in separate System i jobs for each warehouse between the PC and the 
System i. See “Creating an ODBC data source” for more information.  

3. Link the new AVP installation to the System i XA environment. Edit the 
APDataLink.ini file in the new AVP install folder (for example, AVP WH2). See 
“Linking AVP to the XA environment on the System i” for more information.  

You can now optionally rename the newly created Advanced Planner Download and 
Advanced Planner desktop icons, as well as the ODBC connection to the AVP Access 
database, just as you did for the first installation, to clearly identify these items with 
the second warehouse. This also prepares you for an additional installation on the 
same PC. 

Maintaining multiple AVP installations on one PC

To install a new version of the Advanced Planner engine, you must: 

1. Download the new software. 

2. For each installation on the PC: 

a. Uninstall the existing AVP program. Navigate to the install folder for the 
installation and double-click on the Unwise.exe program. 

b. Install the new version into the existing install folder. 
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Chapter  2.   Information flow

AVP uses MRP user interfaces and functions on the System i, and it interfaces to the 
same applications as MRP, other than MPSP and Cameleon. See the MRP User’s 
Guide for more information. The Advanced Planner engine replaces the MRP 
planning run. This chapter provides a summary of the information flow within AVP and 
how it compares with MRP. 

• Before you plan: All supply and demand information, other than master scheduled 
orders from MPSP, used by MRP is used in AVP planning. The demand can come 
from:

- Forecasts from the Forecasting application or directly entered into MRP

- Safety stock

- Customer orders from Customer Order Management (COM, CSM, and 
COM_Net)

- Expected customer orders from Electronic Commerce (EC)

- Planned intersite demand from InterSite Logistics (ISL/MISL)

- Master-level item requirements entered into MRP. 

Most item and warehouse planning codes, horizons, and other parameters from 
MRP planning are also used in AVP planning. 

See Chapter 3. “Preparing for planning“ for more information.

• While you plan: You manage planning from the AVP planning engine. You perform 
the following three steps, either interactively or in batch mode. 

- Download: Demand data is extracted into MRP planning files. All planning 
data is transferred to the AVP engine. During the download process, 
customer orders consume forecasts, and AVP uses only customer orders and 
unconsumed forecasts to plan. 

See Chapter 4. “Downloading data to the Planning Engine“ for more 
information.

- Plan: AVP matches supply against demand and develops a supply plan for 
materials and production resources. You can review, interact with, and modify 
the plan. You use multiple views, drill-downs, “what ifs,” and un-do steps to 
resolve material and capacity issues. AVP stores your actions and you can 
save the plan. 

See Chapter 5. “Using the Advanced Planner engine“ for more information.

- Upload: When you save the plan, AVP extracts data and transfers it to the 
System i, loading it into MRP planning files. The MRP reports you previously 
selected are printed, and supply orders are rescheduled in the order files. You 
can update customer order promised delivery dates according to the plan. 

See Chapter 6. “Uploading data to the System i“ for more information.
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• After you plan: All the functions available to you on the MRP Order/Schedule 
Release and Review menu are available after you plan using AVP, including the 
following: 

- Review and release manufacturing, purchase, and intersite orders

- Auto release purchase orders

- Enter and maintain REP schedules

- Define and send EDI purchase planning schedules via EC. 

- You can also use:

– Order Based Production Management (OBPM) to review and release 
manufacturing, purchase, and intersite orders as you do with MRP using 
the Planner and MRP Recommendations objects. 

– Production Control and Costing (PC&C) to schedule and manage 
released manufacturing orders, per-order due dates as it does with MRP. 

– Capacity Requirements Planning (CRP) to load, print, and view planned 
and open orders, as it does after MRP planning. 

Forecast consumption

AVP consumes forecast demand with customer sales order demand. It plans using 
only the unconsumed forecast and the customer sales demand. It consumes this 
forecast by month, or by smaller periods, if the forecasts are in smaller periods. For 
example, a forecast of 100 per month is divided equally into four weekly forecasts of 
25. A customer places an order for 55 in the third week of the month. AVP consumes 
the third-week forecast of 25, then works toward the beginning of the month, 
consuming the second-week forecast of 25, and then finally consumes 5 of the first-
week forecast of 25. If insufficient forecast exists at the beginning of the month, AVP 
consumes any available forecast to the end of the month. 

The XA Forecasting application stores forecasts by periods, defined in the calendar 
for the warehouse, and inputs forecasts to MRP and MPSP in increments of weeks 
either by period or week. 

Note: Ensure that you convert all the first-year periods you are planning in AVP to 
weeks. If you do not, as months and forecasts have different lengths and the forecast 
is always loaded on the first day of a week, some months may have two forecasts and 
other may have none. This will result in unsatisfactory forecast consumption. 

For each item, you control how AVP uses the forecast and customer demand using 
the same item warehouse codes you use in MRP. AVP uses: 

• Forecast only when the forecast code is type 2 or 3 (Input to MRP or MPSP)

• Customer orders only when the plan customer orders code is 1, 2, 3, or 5

• Expected customer orders from EC only when the plan expected customer orders 
code is A, B, C or D. 

Forecast can be consumed in three ways: 

• Individual item. This is the simplest way as it requires no special coding. The 
sales of each item consume the item forecast. 

• An item and its parents. If many possible finished product configurations exist, 
made from a small number of components, you can forecast at the component 



Contents Index Page 2-3
 Information flow

level rather than the finished product level. No finished product forecast is 
entered. You enter the forecast for the components using a family ID of FULL. 
See “Item and facility” on page 3-1 for more information.  

As AVP consumes forecast at the highest level with a forecast as the 
components, the forecast is consumed there since the customer order demand is 
exploded through the bill of material levels. When an item has the forecast with a 
family ID of FULL, customer orders for that item and any parent of that item 
consume the item forecast. 

• Planning bill family. Identify an item as a planning bill item and enter forecasts for 
the item. See “Item and facility” on page 3-1 for more information.  In the bill of 
material, for the optional components, multiply the quantity required for one unit of 
the planning item bill by the expected percentage usage of that option. AVP 
explodes the forecasts for the planning bill item through the bill of material until it 
reaches a non-phantom item, then it forecasts that item. Do not enter customer 
orders for the planning bill since its bill of material is a component bill that cannot 
be manufactured. Enter customer orders for items with a bill for a specific 
configuration, and when the components in the ordered configuration match the 
components in the planning bill, the forecast is consumed. 

AVP uses the item demand time fence to determine which forecasts to use. AVP 
downloads only forecast beyond the demand time fence (MRP current date plus the 
item demand time fence days) is for planning. If the item demand time fence is 0, the 
MRP current date becomes the item demand time fence. 

If you use forecast consumption, you should move the MRP current date only once a 
week. All forecasts earlier than the current date are dropped during download, as AVP 
considers them past due. For example, the first week forecast from Forecasting is 
deleted when it becomes earlier than the current date. 

If you run AVP daily and move the current date only once a week, change the release 
days daily in order to keep the MRP Release Date a consistent number of days from 
the date planning is run. Each day, additional orders will be flagged for release. For 
example, to flag orders for release if their start date is within three days, and you 
move the current date only once a week, set the release days (Maintain Horizon 
Values in MRP) to 3 on the first day of the week, 4 on the second day, 5 on the third 
day, and so forth. Start with 3 again when you move the current date to start a new 
week.

AVP uses forecast demand from: 

• Forecasting using the Forecast Code

• User-entered information in MRP Maintain Forecast

• User-propagated from fields in the Item Warehouse object and Item Balance file

• User-supplied information from a user program that loads the forecast to the MRP 
Requirements (REQMTS) file with the following fields: 

- Warehouse (RQPLWH)

- Item number (RQCOM)

- Forecast date (RQDUD)

- Forecast quantity (RQQTY)

- Sequence number of 50001 or greater, ensuring that no duplicate key of 
warehouse/item number/date/sequence (RQSEQ) exists

- Source of 5 forecast (RQSOR)



Contents Index Page 2-4
 Information flow

- Origination of 20 or greater (RQORG)

- Blank customer order ID (RQCID). 

The user program must build and maintain the forecast, but need not delete it as 
time passes. Download does not use the forecast in planning if it is inside the 
demand time fence. Download deletes the forecast if it is earlier than the MRP 
Current Date.

AVP uses customer demand from: 

• Customer orders from Customer Order Management (COM), Customer Service 
Management (CSM), and COM_Net, using the plan customer orders code

• Expected customer orders from Electronic Commerce (EC) using the plan 
expected customer orders code 

• User-supplied information from a user program that loads the customer demand 
to the MRP Requirements (REQMTS) file with the following fields: 

- Warehouse (RQPLWH)

- Item number (RQCOM)

- Required date (RQDUD)

- Order quantity (RQQTY)

- Sequence number of 70001 or greater – ensuring that no duplicate key of 
warehouse/item number/date/sequence (RQSEQ) exists

- Source of 6 or 7 (manual or held requirement) (RQSOR)

- Origination of 20 or greater (RQORG)

- Non-blank customer order ID (RQCID). 

The user program must build and maintain the customer demand entirely, 
including deleting the demand when the order is shipped. Download deletes the 
customer demand if the source (RQSOR) is 6 and is earlier than the MRP current 
date, or if the source is 7 and is earlier than the MRP start date. 

Two types of demand are input to AVP as both forecast demand and customer 
demand. No forecast from the preceding sources is consumed by this demand. 

• Intersite orders, both planned and open. InterSite Logistics (ISL/MISL) records 
intersite shipments as inventory transfers, not sales. Intersite demand is not 
included in forecast (based on sales), so you must plan it in addition to forecast. 

• User master level item requirements entered in MRP Maintain Master Level Item 
Schedules or propagated from fields in the Item Warehouse object and Item 
Balance file. You can enter special demand of any type and have it directly affect 
the plan in addition to forecast, as requirements do in MRP.

AVP also plans safety stock in addition to any other forecast or customer demand, just 
as it plans the preceding two types of demand. 

Total and unconsumed forecast

MRP shows forecast demand two places: 

• All forecasts appear in Forecast Demand and are used with customer orders to 
compute Greater Demand in the following: 

- Review Forecast/Orders display (AMM451)
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- MLI Requirements vs. Forecast/Orders display (AMM351)
- MLI Requirements vs. Forecast/Orders report (AMM221). 

• Forecast requirements, used in MRP planning, appear in Requirements or 
Planner Requirements, in the following: 

- MLI Requirements vs. Forecast/Orders display (AMM351)
- Item Requirements Inquiry display (AMM511)
- MLI Requirements vs. Forecast/Orders report (AMM221)
- Requirements Planning and Master Items Planning reports (AMM3A1). 

AVP shows the total forecast in Forecast Demand, and after planning, it shows only 
the unconsumed forecast in Requirements (identified as Forecast Requirements – 
FCR or FCST REQ). Only the unconsumed forecast is used in planning. 

The download and upload processes manage the MRP requirements (REQMTS) file, 
so the MRP displays and reports show only unconsumed forecast as forecast 
requirements. Download deletes all types of forecast requirements records:

• Source (RQSOR) is 6 or 7
• Origination (RQORG) is 1, 6, or 20 or greater
• Customer order ID (RQCID) is blank. 

Upload builds forecast requirements records for the unconsumed forecast: 

• Source (RQSOR) is 6
• Origination (RQORG) 6
• Customer order ID (RQCID) is blank. 

The interface between FCST and AVP is different from the interface between FCST 
and MRP. The same forecast data is loaded from FCST to MRP files in FCST 
Forecast Load to Master Schedule, based on the frozen, firm, and free period days 
you specified in FCST Forecast Control. AVP treats the FCST data differently in two 
ways:

• AVP uses the forecasts, not the forecast requirements. Download deletes all 
forecast requirements and upload rebuilds them with only the unconsumed 
forecast. 

• Only forecasts outside the item demand fence (Current Date + demand time 
fence days) are downloaded. 

AVP shows forecast similarly to the way MRP shows it. The total forecast from all 
sources appears in Forecast Demand. Only the forecast used in planning appears in 
Requirements. The difference is that AVP consumes forecast to determine the 
forecast used in planning and updates the MRP requirements file with the results. 
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Chapter  3.   Preparing for planning 

Advanced Planner (AVP) uses the same supply and demand information as MRP. You 
prepare for planning with AVP in a similar manner to MRP. This chapter reviews the 
data used in AVP and identifies the differences between MRP and AVP. 

Item and facility......................................................................................................... 3-1
Demand.................................................................................................................... 3-5
Supply....................................................................................................................... 3-5
Warehouse control ................................................................................................... 3-6

Item and facility 

The item and facility information includes the following: 
Item definition and source

Lead time code, bills of material and routings for manufactured items (either from 
PDM, PDMPlus, or EPDM), and lead times for purchased items

Demand parameters
Forecast Code, Plan Customer Orders Code, and Plan Expected Customer 
Orders Code, to control the demand from outside MRP to use in planning, and 
Master Level Forecast Code, Number of Periods, Days per Period, and Forecast 
Quantity, to propagate either forecast or requirements

Ordering parameters
Safety stock, number of days supply, and order minimums, multiples and 
maximums

Automatic rescheduling parameters
Item reschedule code and rescheduling frozen zone

Production facility definitions
Calendar, capacity, utilization, and queue time

The differences relating to item information between AVP and MRP include the 
following: 
Combining requirements

AVP uses the Combine Customer Orders option (specified for the warehouse in 
Planning Run Execution Options) but does not combine requirements according 
to the item warehouse Combine Requirements Code.

Master level items
AVP treats all non-blank master level item codes as M (multiple source).

Order planning
AVP uses four item lot-sizing parameters to plan order quantities: 

• Aggregation period (days supply in MRP) when used with order policy code G 
(time periods of supply)

• Minimum

• Multiple

• Maximum

AVP determines planned order quantities for all items as follows: 

1. Subtracts on-hand, open orders, and firm planned orders from the time-
phased item demand to get time-phased net demand
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2. Totals the net demand over the item aggregation period

3. Increases to the item minimum, if the item minimum is larger than the net 
demand

4. Rounds up to a multiple of the item multiple if an item multiple is specified

5. If an item maximum is specified: 

• If purchased, plans the order and issues an exception if the order quantity 
is larger than the item maximum, 

• If manufactured, plans the order for the item maximum if the order 
quantity is larger than the item maximum 

6. Subtracts the order quantity planned from the demand, and returns to step 2. 
until orders are planned for all demand. 

AVP downloads item lot sizing parameters based on the item order policy code, 
so the following order policy codes are planned almost exactly as they are in 
MRP: 

A Discrete
D Fixed quantity
G Time periods of supply
H Discrete above a minimum

Specifically: 
Aggregation period

If the order policy code is G and a number of days supply is specified, it is 
downloaded; otherwise, 1 is downloaded. 

Minimum
If the order policy code is D or H and the fixed order quantity is greater than 
the minimum, the fixed order quantity is downloaded; otherwise, the minimum 
is downloaded

Manufacturing Order lead times
AVP calculates lead times for manufacturing orders using order quantity and 
routing and facility data, specifically facility standard queue time and operation 
setup time and runtime. It also assumes that, except for operations in which the 
entire order is processed at once (time basis codes C and H), operation times are 
overlapped as individual items are moved to the next operation as they complete 
the current operation. Therefore, you should review and update facility standard 
queue times, as they are used to determine planned manufacturing order lead 
times. 

Purchase time fences
AVP does not consider the Firm Time Fence or the Authorized Time Fence. 
Purchase orders are flagged for release only if their start date is on or before the 
Release Date.

Order rescheduling
If an item reschedule code is left as 0 (the MRP default for the warehouse 
reschedule code), AVP defaults purchased items and master level items to 1 (no 
automatic rescheduling) and all other items to 4 (automatic reschedule in and 
out). 

The minimum days to reschedule field (in both the warehouse and item) is 
ignored. In other words, it is treated as 1 for all items. 

The automatic reschedule options for all three types of orders, specified when you 
initiate an MRP Planning run, are treated as Yes. 
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The Due date in past (automatic reschedule options) for all three types of orders, 
specified in Planning Run Execution Options, are handled based on the 
reschedule frozen zone: 

• If the reschedule frozen zone is 0, AVP uses no frozen zone. For items 
specified as automatic rescheduling, the order is rescheduled to align with the 
demand. 

• If the reschedule frozen zone is positive, the past due order is in the frozen 
zone, and is not rescheduled. 

Schedule controlled (REP) items 
• Alternate operations in PDM

• Additional item processes in EPDM. 
AVP plans schedule controlled items using a single operation routing based on 
the information in the item line (ITMLIN) record for the primary production line for 
the item. The production line becomes the workcenter. You can view the schedule 
as one step during planning. If an item has multiple item lines, the following are 
downloaded so you can offload or alternate route a planned REP schedule to an 
alternate production line during AVP planning: 

After planning, REP schedules are created and maintained in Enter and Maintain 
Schedules, as they are with MRP.

KBC items
AVP identifies KBC-configured items using a unique item number composed of 
the item number and a 7 digit sequence number for each configuration of the 
item. Download uses this unique number to send all information for the 
configuration: 

• An item, bill, and routing

• The customer order line item

• When released, the open manufacturing order. 

The sequence number appears only in the AVP engine, not the System i. 

PPITEM file
Three additional item fields are supported in a user-controlled PPITEM file. 
Download generates a record in this file for each item planned by AVP, but you 
must use either DFU or DSPFILE to enter and maintain data in any of these fields. 

• The Family ID (FMID) applies to forecasts for the item. 

Blank (default) Consume forecast only by customer orders directly for this 
item

FULL Consume forecast by any customer order that uses the item, 
either parent or component

FamilyName Consume the forecast by any customer order for an item in 
this forecast family 

• Forecast Family ID (PRTF) applies to sales of the item. 

Blank (default) Customer orders for this item consume all forecasts for 
this item

FamilyName Customer orders for this item consume only forecasts for this 
forecast family 

• Planning bill item (PLNB) is used for forecast consumption. 

0 (default) No
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1 Yes
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Differences relating to facility information are the following:
Calendars

AVP does not download calendars. You must maintain calendar information on 
both the System i and the planning engine.

Capacity
AVP defines one capacity unit per facility, not one per shift.

Queue times
AVP defines two queue times per facility: Typical and Minimum. These are 
defined as MIN_BUFFER_TIME and TYPICAL_BUFFER_TIME in the AVP 
engine. The standard queue time is downloaded to the typical queue time, and 
you must maintain the MIN_BUFFER_TIME on the AVP engine. See Chapter 5. 
“Using the Advanced Planner engine“ for more information.

Demand

The demand information includes the following: 

• Forecast demand from ERP Forecasting (FCST), entered by the user or 
propagated in MRP, and user supplied to the requirements file using a user 
program. 

• Customer order demand from COM, CSM, and COM_Net, expected customer 
orders from EC, and user supplied to the requirements file using a user program. 

• Safety stock and other demand used as both forecast and customer order 
demand from intersite orders, both planned and open from ISL/MISL, and master-
level item requirements entered by the user or propagated in MRP. 

Demand warehouses associated with planing warehouses are supported as they are 
in MRP so forecast and customer order demand and safety stock from demand 
warehouses is included in AVP. 

Differences relating to demand information are described in “Forecast consumption” 
on page 2-2. 

Supply

The supply information includes: 

• On hand inventory
• Open manufacturing orders, and released and unreleased REP schedules
• Open purchase orders, blanket orders, and requisitions, and open intersite orders
• Firm planned manufacturing, purchase and intersite orders as supported in MRP.

Demand warehouses associated with planning warehouses are supported as they are 
in MRP, so on-hand inventory from demand warehouses is included in Advanced 
Planning. 

Differences regarding manufacturing allocations are described in the next section in 
the Time Phased Allocations paragraph. 
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Warehouse control

The warehouse control information includes the following: 

• Warehouse ID, and Site ID

• MRP planning horizons as specified in Maintain Horizon Values: 

- Current date
- Release date
- Start date.

• MRP planning options as specified in Planning Run Execution Options: 

- Cancel exception code
- Maximum demand sources to track 
- Track demand sources for on hand quantity
- Rescheduling frozen zone
- Safety stock lead time.

• Warehouse calendar dates: Last work day, and Last work day less one month (for 
Cancel exception code). 

The differences relating to the warehouse control information are as follows:

• Time Phased Allocations: The AVP engine plans all allocations to manufacturing 
orders and REP schedules as time phased, regardless of the allocation days in 
Maintain Horizon Values and the time-phased allocations option in Planning Run 
Execution Options. In AVP, these options still control whether allocations are 
stored as requirements in the REQMTS file, and how they appear on MRP 
displays and reports, and how they are treated in component availability checking 
during manufacturing order release in MRP or OBPM. 

• Combine code intervals: AVP does not combine requirements according to the 
item warehouse combine requirements code.

The following Planning Run Execution Options do not apply: 

• Level to plan master level items: AVP plans all items

• Warehouse reschedule code: AVP defaults as discussed in the preceding Order 
rescheduling section

• Minimum days to reschedule orders: AVP does not use this field. 

• Due date in past automatic rescheduling options, for manufacturing orders, 
purchase orders and REP schedules since AVP defaults as discussed above in 
Order rescheduling. 

• Extract requisitions: AVP always extracts all requisitions. 

AVP performs the following for the Initiate Planning Run options:

• Extract independent demand is done if COM is installed and interfacing

• Transfer new master scheduled orders is not done, as MPSP is not supported

• Perform purchasing auto release is not done; may be run after planning from 
MRP menu AMMM40

• Automatic reschedule options, for manufacturing orders, purchase orders and 
REP schedules defaults to Yes for all. 

• Planning run type is not applicable since AVP plans all items. 
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Chapter  4.   Downloading data to the Planning Engine

You download data to the planning engine as the first step in planning. Run Advanced 
Planner Download, either from the icon on your desk top or by selecting Start > 
Programs > Advanced Planner 6.0. Forecast and customer sales order demand data 
is extracted into MRP work files, and planning data is transferred to the engine. The 
following options apply to download and should be reviewed and set before running 
download. See “What to do” for more information.  

• You can download in either test or planning mode. You can save the plan and 
upload data to the System ionly in planning mode. This will give different results in 
MRP. 

- Test is the default. 

- You can run in planning mode only if AVP is active in the warehouse. 

• If EPDM is active, you can specify how many item processes and their 
corresponding bills of material and routings are downloaded. You can download 
only the current primary process for an item (default), all current and future 
primary processes for an item, or all current and future processes for an item. 

• You can print download audit reports that include only errors or include all details. 

• You can specify the minimum hours for long operations. This allows you to 
download in-process hours for long operations so the engine can more accurately 
know how much time is required to complete the operation. In-progress records 
are sent for in-process long operations. 

• You can activate or deactivate AVP in the warehouse. 

Activating AVP in a warehouse

You must activate AVP in a warehouse before you can download in planning mode. 
Activating AVP sets a flag in the AVP control file on the System i for that warehouse. 
This flag prevents MRP planning from running either interactively or from a 
SBMMRPPLN command. It also saves and clears the MPSP item codes (MSIC) for 
items in the warehouse in order to disable the interface between MRP and MPSP. 
AVP and MRP process requirements differently during planning; therefore, only one or 
the other can plan a warehouse. 

If you must restore the MPSP item codes and plan the warehouse using MRP and 
MPSP, you can deactivate AVP in the warehouse, which turns off the AVP active flag 
and restores the MPSP item codes. If you have run AVP planning, forecast 
requirements may have changed to reflect only unconsumed forecast. This will give 
different results in MRP. 

Ideally, you should test AVP in a separate test environment before you activate it in 
your operational environment, particularly if you are running MPSP or will be 
consuming forecast. This lets you activate it and save the plan and upload the data to 
the System i and review it the way you normally do your MRP plan without disrupting 
your live MRP data. 
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What to do

Edit the APDataLink.ini file to specify the options for download to planning. 

Env Type in your XA environment ID. 

Warehouse Type in the warehouse number of the warehouse to be 
planned. 

DownLoad One of the following: 

0 Default. Test. You can run this while MRP (and, 
optionally, MPSP) is planning the warehouse in order 
to test the planning engine operation. This mode 
saves no data on the System i, and does not allow 
you to upload after planning. 

1 Plan. You can run in planning mode only if AVP is 
active in the warehouse. You can save the plan and 
upload it after planning. This mode conflicts with the 
following MRP jobs from download until upload 
completion: 

• Maintain forecast
• Maintain MLI requirements
• Maintain horizon values
• Maintain period intervals 
• Planning run execution options
• Order review and approve
• OBPM MRP recommendations. 

See Chapter 6, “Uploading data to the System i” on 
page 6-1 for more information.  

[ODBC]
DataSourceName=AP60
UserId=SCM
Password=SCM
[Download]
Env=66
Warehouse=TP6
DownLoad=0
LoadItem=0
PrintReport=1
Hours=0000008
[Upload]
COMPromiseDate=0
COMDueDate=0
[Download Files]
InputFileDir=C:\MAPICSADVPLAN\SampleDBAP\
CommaSeparated=0
ShowColumnHeader=0
Delimiter=
[Debug]
DebugDesign=0
DebugUpload=0
[System]
AVPActive=0
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LoadItem Applies only if EPDM is active. Specifies how many item 
processes, and the corresponding bills of material and 
routings, are downloaded for planning. With any option, only 
current and future processes are downloaded. One of the 
following: 

0 Default. Only the current primary process for an item. 

1 All current and future primary processes for an item

2 All current and future processes for an item. 

PrintReport One of the following:

0 Print no download audit reports

1 Default. Print errors only. 

2 Show the detail of everything that is downloaded. 

Hours Type in the minimum hours for a long-running operation. The 
default is 8. The maximum is 9999999. Only operations with 
either setup time or runtime per piece (or order, if the time 
basis code is C or H) greater than this value are considered 
long operations. In-progress information, with the remaining 
setup or run time, is downloaded for long operations that are 
in process. 

AVPActive One of the following, to activate or deactivate AVP in the 
warehouse in the next download: 

0 (Default). AVP is not activated in the warehouse. 
1 AVP is activated, if not already active, in that 

warehouse. 
2 AVP is deactivated in the warehouse. 

Downloaded data

This table lists the information sent to AVP. Each file is further described on the 
following pages in this chapter. 

Download file (ERP workfile 
name) Contents/Purpose See page ...
Item (PPIPRT) Planned by MRP/AVP 4-4
Item Process (PPIPRC) Item processes (EPDM only) so 

the engine can select the correct 
item process for a planned order 
and a user can select an alternate 
process to off load overloaded 
facilities

4-7

Bill Of Material (PPIBOM) From PDM, EPDM, and KBC 4-8
Routing (PPIRTG) From PDM, EPDM, and KBC 4-9
Workcenter (PPIGWKC) From PDM and EPDM 4-10
Forecast (PPFCS) From FCST, MRP, and ISL/MISL 4-11
Sales (PPICOM) Customer orders from COM/CSM, 

expected customer orders from 
EC, planned intersite demand, 
and MLI requirements from MRP

4-12
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Item (PPIPRT)

AVP plans an item only if the item is planned by MRP or both MRP and APS, and is 
not a kit, miscellaneous or service item, or an APC/Cameleon item. If KBC is installed, 
download creates a unique item number for each KBC configuration on a customer 
order and each component in a KBC bill that also has a KBC bill of material. It does 
this by appending a sequence number to the item number in order to create a unique 
item number for the item and its associated data. These items, bills, and routings are 
extracted from the KBC configuration files. 

Inventory (PPIINV) On-hand quantity 4-13
Workorder Heading (PPIMOM) Manufacturing orders and REP 

schedule masters, and firm 
planned manufacturing orders 
and REP schedules

4-14

Workorder Allocation (PPIMOD) Component allocations for 
manufacturing orders and REP 
schedules 

4-15

Workorder Routing (PPIMOR) Operations for manufacturing 
orders and REP schedules

4-16

Jobs in Progress (PPIJIP) Hours remaining for in-progress 
long operations

4-17

Purchase (PPIPUR) Purchase orders and requisitions, 
intersite orders, and firm planned 
purchase or intersite orders

4-18

Warehouse Control (PPIPLN) MRP warehouse planning control 
parameters

4-19

Download file (ERP workfile 
name) Contents/Purpose See page ...

AVP field ERP source
Item ID Item number (ITNB in ITMPLN); if KBC, ITNB and a 7-

position sequence number
Item Description Item description (ITDSC in ITMRVA)
Item Type 
(0=manufacturing order; 
1=purchase order

If lead time code (LTCOD in ITEMBL) is M: 0. 
Otherwise, 1

Analyst ID Planner (PLANIB in ITEMBL)
Manufacturing Unit of 
Measure

Stocking unit of measure (UNMSR in ITMRVA)

Selling price Base price (BZANVA from MBBZREP for the system 
date) if not 0. Otherwise, Base price (BZANVA in 
ITMRVA)

Forecast family ID Forecast family ID (IPPRTF from PPITEM)
Safety stock (A forecast is 
created for the safety stock 
quantity due {Current date 
+ planning fence})

Sum of the safety stock (SAFTY in ITEMBL) in the 
warehouses (the planning warehouse and all 
associated demand warehouses) where Include 
Inventory Balance (ININ in ITEMBL) is 1 (Yes).
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Planning Fence (used with 
safety stock)

Safety stock lead time as defined in the MRP option for 
warehouse (established on display AMM151) (SFTY in 
PLNINF for warehouse):
1 (LT) Item lead time (M or P used by MRP)
2 (Current) 0
3 (Cum Mtl LT) Cum Material LT (CMTLT in ITEMBL)
4 (Cum Mfg LT) Cum Manufacturing LT (CMFLT in

ITEMBL)
Ordering information
Aggregation period (in 
days)

If order policy code (ORDP in ITEMPLN) is G and days 
supply (NODS in ITMPLN) is greater than 0: NODS. 
Otherwise, 1

Minimum Lot If order policy code (ORDP in ITMPLN) is D or H and 
the fixed order quantity (FXORQ in ITEMBL) is greater 
than the minimum (MINQ in ITMPLN): Fixed order 
quantity (FXORQ); otherwise, Minimum (MINQ).

Multiple Of Multiple (MULQ in ITMPLN)
Reschedule flag If item reschedule code (ITRC in ITMPLN) is 1 through 

4, the reschedule flag is sent. If the item reschedule 
code is 0, the code defaults to 1 (no automatic 
rescheduling) for purchased and master-level items; 
otherwise, 4 (automatic reschedule in and out).

Frozen period Item reschedule frozen zone (RSFZ in ITMPLN)
Manufacturing information
Make Max Lot Maximum quantity (MAXQ in ITMPLN)
Primary Route ID If more than one item process is downloaded for this 

item, the sequence number of the current effective item 
process; otherwise, blank. 

Phantom type (0=No; 
1=Yes)

If item type (ITTYP in ITMRVLA) is 0 (phantom): 1; 
otherwise, 0

Planning bill item (0=No; 
1=Yes)

Planning bill item (IPPLNB from PPITEM)

Purchasing information
Cost (Purchasing parts 
only; AVP computes costs 
for manufacturing parts)

If IM tailoring (CSTCD in the STATI0 record in SYSCTL) 
is one of the following: 
1 Standard unit cost (STDUC in ITEMBL)
2 Average unit cost (AVCST in ITEMBL)
Neither 1 or 2: last unit cost (LCOST in ITEMBL)
If cost from above is 0: unit cost default (UCDEF in 
ITMRVA)

Yield 1 — Shrinkage factor (SHFC in ITMPLN)
Raw Material Type:
2 Priority
1 Ignore
0 Normal

If LTCOD is P and constrained part (CPAR in ITMPLN) 
is 1 (Yes): 2
If LTCOD is P and constrained part (CPAR in ITEMPLN) 
is 0 (No) and floor stock (FLSTK in ITEMBL) is U 
(uncontrolled): 1
If LTCOD is P and constrained part is 0 (No) and floor 
stock is not U: 0

Primary Vendor ID If not blank: Vendor (VNDNR in ITEMBL); otherwise, 
Vendor (VNDNR in ITMRVA)

AVP field ERP source
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Buyer ID Buyer (BUYNO in ITMRVC)
Buyer Lead Time Purchase review time (LTREV in ITEMBL)
MRP Lead Time (typical) Purchase vendor (LTVEN in ITEMBL) plus Purchase 

(LTSAF in ITEMBL)
Minimum MRP Lead Time Purchase vendor (LTVEN in ITEMBL)
Dock to Stock Lead Time Purchase adjustment (LTADP in ITEMBL)

AVP field ERP source
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Item Process (PPIPRC)

If EPDM is active, item processes and their associated bills of material and routings 
that are requested in the LoadItem Download option are downloaded. See “What to 
do” for more information.  This lets AVP select the correct primary process for planned 
orders and the user select alternate processes for planned orders in order to resolve 
resource problems. An item process specified in a firm planned order is downloaded 
regardless of the download option specified. No item process records are sent for 
KBC configurations since each configuration has a unique item number with one bill 
and routing. For REP items, if multiple item line records exist for one item process, 
AVP downloads an item process for each item line so you can alternate route a 
planned, firm planned, or created but unreleased REP schedule to another production 
line. 

AVP field ERP source
Item ID Item ID
Item revision ERP item revision
Revision start date Revision effective-from date
Revision end date Revision effective-to date
Route ID Sequence number of the item process, generated in 

download since the ERP item process token contains 
packed data that does not translate into ASCII

Description Process description
Primary process 1: Primary

0: Alternate
Process start date Process effective-from date
Process end date Process effective-to date
ERP alternate BOM ID ERP Alternate BOM ID
ERP routing ID ERP Routing ID
ERP Routing version ERP Routing version
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Bill of Material (PPIBOM)

If PDM is active, the download sends the bill for each manufactured item from 
PSTRUC. If EPDM is active, the download sends the bill from PSTDTL for each item 
process sent. For S-numbered items feature/option records, the F/O planning factor 
(FOPPF) is multiplied by the quantity per to compute the Quantity Per sent. The bill for 
each KBC configuration is set in TCFOBM. 

AVP field ERP source
Parent item ID If not a KBC configuration: Parent item number

If a KBC configuration: Item number and a 7-position 
sequence number

Route ID If EPDM is active and not a KBC configuration: the 
sequence number of the item process; otherwise, blank

Item ID (Component) If not a KBC configuration: Component item number
If a KBC configuration: Item number and a 7-position 
sequence number

Quantity Per 1 If not KBC, and the standard batch quantity is
greater than 0: (QTYPR/standard batch quantity);
otherwise: Quantity per unit (QTYPR)

2 If not KBC and a feature/option record: the results of
step 1 (above) times FOPPF

3 If KBC, and the standard batch quantity is greater is
greater than 0: (COQP/standard batch quantity);
otherwise: Quantity per unit (COQP in TCFOBM)

Job Step If REP schedule: 0001; otherwise, Operation where first 
used. 

Effective From Date If not KBC and Effective from date (EDATM) is not 0: 
EDATM; otherwise, 01011901

Effective To Date If not KBC and effective date (EDATO) is 0 and 
American: 12312099
If not KBC and effective date (EDATO) is 0 and not 
American: 31122099
If not KBC and effective date (EDATO) is not 0: EDATO
If KBC and American: 12312099; otherwise, 31122099
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Routing (PPIRTG)

If PDM is active, the routing for each manufactured item is sent from ROUTNG. If 
EPDM is active, the routing is sent from RTGOPR for each item process sent. No 
routing is sent for a phantom item. For REP items, a one-step (0001) routing is sent 
based on data from the item line (ITMLIN) file. The routing for each KBC configuration 
is sent from TCFOOO. 

AVP field ERP source
Item ID If not a KBC configuration: Item number

If a KBC configuration: Item number and a 7-position 
sequence number. 

Route ID If EPDM is active and not a KBC configuration: the 
sequence number of the item process; otherwise, blank

Route Priority If PDM is active, and a routing for a REP item alternate 
production line, download numbers starting with 1; 
otherwise, 0. 

Job Step If a REP item: 0001; otherwise, the operation sequence 
number

Workcenter If a REP item and primary line: the primary production 
line (PRLIN from ITEMBL)
If a REP item and alternate line: Production line (PLINE 
from ITMLIN)
If position 1 of FCPS resource constraint (FCP1) is 
asterisk (*): positions 2-6 of FCP1; otherwise, Facility

Batch Size If not a REP item and time basis code is C or H: all 
nines; otherwise, 1

Setup time in seconds If REP: changeover time + flow time - run time for one 
unit multiplied by 3600; otherwise, if prime load code is 
2, 3, or 5 and setup crew size is greater than 0: Setup 
time divided by Setup crew size and converted to 
seconds; otherwise, 0

Run time per batch in 
seconds

If REP: Item rate converted to hours per piece if rate 
designator is P and multiplied by 3600; otherwise, if 
prime load code is 1 or 3: run machine hours converted 
to hours per piece or lot, based on the time basis code 
and multiplied by 3600; otherwise, if prime load code is 
4 or 5: run labor hours converted to hours per piece or 
lot based on the time basis code and multiplied by 3600

Yield If REP: 1; otherwise, current operation yield
Idling time per batch in 
seconds

If REP: 0; otherwise, the greater of the facility output 
buffer hours or operation output buffer hours multiplied 
by 3600. 

Step description If REP: Facility (production line) description; otherwise, 
operation description

Tool ID If REP: blank; otherwise, tool number and FCPS 
resource information if present
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Workcenter (PPIWKC)

If PDM is active, the facilities are sent from the WRKCTR file. If EPDM is active, the 
facilities are sent from FACMST. 

AVP field ERP source
Workcenter ID Facility ID
Workcenter description Facility description
Units Largest of the desired capacities (shift 1, shift 2, or shift 

3)
Max planned utilization If the sum of the maximum capacities for the three shifts 

is not greater than zero: .95; otherwise, if the sum of the 
desired capacities divided by the sum of the maximum 
capacities is not greater than 1: the result; otherwise, 1. 

Calendar name Production calendar name
Dummy flag 
0 Normal
1 Ignore
2 Outside processing

If prime load code is 0 (no load): 1; otherwise, if the time 
basis code from a routing operation for this facility is C: 
2; otherwise, 0

Family Facility group
Typical queue time in 
seconds

If REP production line: 0; otherwise, the standard queue 
time in days multiplied by the daily scheduling capacity 
in hours multiplied by 3600.

Minimum queue time in 
seconds

Not sent; you maintain it in the AVP engine

Overtime rate If the prime load code is 2: the current setup labor rate 
multiplied by 1.5; if the prime load code is 4 or 5: the 
current run labor rate multiplied by 1.5; otherwise, 0
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Forecast (PPIFCS)

Forecasts are sent for the following types of records in the requirements file if the 
forecast date is on or after the item demand time fence (MRP Current Date plus the 
Item demand fence days): 

Forecast type Source Origination Comments
Forecasts (from FCST) RQSOR=5 RQORG=1
User-entered forecasts 
from MRP

RQSOR=5 RQORG=0

User-propagated forecasts RQSOR=1 RQORG=0
User forecasts from user 
programs

RQSOR=5 RQORG=20/+ Order ID-RQCID is blank

Intersite orders, planned 
from ISL

RQSOR=5 RQORG=8

Intersite orders, customer 
orders from ISL

RQSOR=6,7 RQORG=0 Order ID-RQCID is 
present

User-entered requirements 
from MRP

RQSOR=6,7 RQORG=0 Order ID-RQCID is blank

User-propagated 
requirements

RQSOR=2 RQORG=0

AVP field ERP source
Item ID Item number
Forecast ID FCST + YYYYMMDD (forecast date/RQDUD in 

REQMTS)
Item family Family ID (FMID from PPITEM)
Forecast date Forecast date (RQDUD in REQMTS)
Forecast quantity Forecast quantity (RQQTY in REQMTS)
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Sales (PPICOM)

Sales are sent for the following types of records in the requirements file: 

Order type Source Origination Comments
Customer orders from 
COM, COM_Net

RQSOR=6,7 RQORG=0 Order ID-RQCID is 
present

Expected customer orders 
from EC

RQSOR=6,7 RQORG=11-15 Order ID-RQCID is 
present

User customer orders from 
user programs

RQSOR=6,7 RQORG=20+ Order ID-RQCID is 
present

Intersite orders, planned RQSOR=7 RQORG=8
Intersite orders, open RQSOR=6,7 RQORG=0 Order ID-RQCID is 

present, and an intersite 
order exists

User-entered requirements 
from MRP

RQSOR=6,7 RQORG=0

User-propagated 
requirements

RQSOR=2 RQORG=0

AVP field ERP source
Item ID If not a KBC configuration: Item number. If a KBC 

configuration: Item number and a 7-position sequence 
number.

Promise date If a CO: Current manufacturing due date (RQDUD in 
REQMTS)

Order quantity Required quantity (RQDUD in REQMTS)
Order ID Company (RQCONO) + Order ID (RQCID) + Release 

(RQRLNO) + Kit release (RQKTRL)
Line number Line item sequence (RQLNSQ)
Customer ID If a CO: Customer number in Quote/order header
Selling Price If a CO: Net unit selling price include order-level fixed 

and variable trade discounts; otherwise, base price 
(BZANVA from MBBZREP for the system date) if not 0. 
Otherwise, Base price (BZANVA in ITMRVA)

Requirement sequence 
number

RQSEQ in REQMTS for use in upload



Contents Index Page 4-13
 Downloading data to the Planning Engine

Inventory (PPIINV)

On-hand inventory is sent for items other than KBC configurations. Once a KBC 
configuration is built, it should be received and shipped, as the configuration cannot 
be identified in stock. The customer order shows a demand for the item number 
including the 7-position sequence number and the on-hand (supply) shows the base 
item number without the sequence number. 

AVP field ERP source
Item ID Item number
On-hand quantity The sum of the on-hand quantity (MOHTQ in ITEMBL) 

in the warehouses (planning and all associated demand 
warehouses) with the Include Inventory balance (ININ in 
ITEMBL) of 1 (Yes)
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Workorder Heading (PPIMOM)

All manufacturing orders and REP schedules (from MOMAST) with order status 
(OSTAT) of 00 through 40 or 50 and an open quantity, and all firmed planned orders 
(from PLNORD) are sent for planned items. 

AVP field ERP source
Item ID If not a KBC configuration: Item number. If a KBC 

configuration: Item number and a 7-position sequence 
number. 

Workorder type
R Released workorder
P Firm planned order

If a created order in MOMAST: R; if a firm planned order 
in PLNORD: P

Workorder ID If MOMAST: manufacturing order, or REP schedule ID, 
and if an unreleased REP schedule, S in the first 
position is replaced with U. If PLNORD: download 
generates a unique order ID

Workorder status (one 
character)

If MOMAST: first position of order status (OSTAT); if 
PLNORD: 0

Workorder route ID for firm 
planned orders

PLNORD and EPDM is active: the sequence number of 
the item process for this planned order

Original quantity The order quantity (ORQTY) plus the deviation quantity 
(QTDEV) minus the split order quantity (QTSPL) divided 
by the cumulative yield of all operations (CUMCY)

Quantity finished Quantity received (QTYRC) divided by the cumulative 
yield of all operations (CUMCY)

Quantity scrapped Scrap quantity (QTSCP)
Release date MOMAST: the scheduled start date (SSTDT); if 

PLNORD: Order start date (POSTD)
Due date MOMAST: Due date (ODUDT); if PLNORD: Due date 

(PODUD)
Reschedule flag (0-5) Order reschedule code (ORRC)
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Workorder Allocation (PPIMOD)

For workorders sent from MOMAST, component allocations not yet issued (quantity 
required is greater than quantity issued) are sent. For unreleased REP schedules, 
download builds these records from the bill of material for the item; if EPDM is active, 
the bill of material for the item process in MOMAST. 

AVP field ERP source
Workorder ID If MOMAST: Manufacturing order or REP schedule ID, 

and if an unreleased REP schedule, S in the first 
position is replaced with U. If PLNORD: download 
generates a unique order ID. 

Child item ID If not a KBC configuration: Item number. If a KBC 
configuration: Item number and a 7-position sequence 
number. 

Job Step If REP schedule: 0001; otherwise, Operation where first 
used. 

Sequence number User sequence number
Quantity required Quantity required
Quantity issued Quantity issued to date
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Workorder Routing (PPIMOR)

For workorders sent from MOMAST, active operations (OPSTC is not 00) are sent. 
For REP schedules, a one-step (0001) routing based on data in MOMAST. 

AVP field ERP source
Workorder ID If MOMAST: Manufacturing order or REP schedule ID, 

and if an unreleased REP schedule, S in the first 
position is replaced with U. If PLNORD: download 
generates a unique order ID. 

Job step If REP: 0001; otherwise, the operation sequence 
number

Job step status For open manufacturing orders if OPSTC in MOROUT 
is greater than 30: C; otherwise, the first position of 
OPSTC in MOROUT. For unreleased REP schedules: 
1; for released REP schedules: 3

Workcenter REP: PLINE from MOMAST; otherwise, if the actual 
facility is not blank: the actual facility (AWRKC); if the 
actual facility is blank: the standard facility (WKCTR)

Batch size If not a REP schedule and the time basis code is C or H: 
all nines; otherwise, 1

Quantity good Quantity complete to date, adjusted for splits, if required
Quantity bad Quantity scrapped to date
Item ID If not a KBC configuration: Item number; if a KBC 

configuration item: Item number plus a 7-position 
sequence number



Contents Index Page 4-17
 Downloading data to the Planning Engine

Jobs in Progress (PPIJIP)

For open manufacturing orders, operations in progress with a quantity remaining and 
either the setup time or runtime per piece (or per order, if the time basis code is C or 
H) is greater than the minimum hours for long operation specified in the Download 
options. 

For time basis codes except C, setup and runtime remaining are calculated based on 
hours reported to date. This assumes the job is performing according to standards, 
adjusted for standard efficiency. 

For time basis code C, setup and runtime remaining are calculated based on the time 
elapsed since the previous operation completion (or the job start date, if this is the first 
operation). This assumes the job is progressing as scheduled. No reporting is 
expected until the job is received back from the vendor. 

AVP field ERP source
Work order ID If MOMAST: Manufacturing order or REP schedule ID, 

and if an unreleased REP schedule, S in the first 
position is replaced with U. If PLNORD: download 
generates a unique order ID. 

Job step Operation sequence number
Workcenter If actual facility is not blank: the actual facility (AWRKC); 

otherwise, the standard facility (WKCTR)
Workcenter unit A sequence number generated in download. For normal 

facilities, download sends no more JIP records than 
units in the facility, and sends the records with the latest 
transaction date first. See “Workcenter (PPIWKC)” for 
more information.  For outside processing facilities (time 
basis code C—see Dummy Flag in the Workcenter file), 
all JIP records are sent. 

Quantity in progress If time basis code is C or H: Order quantity plus 
deviation quantity minus split quantity minus quantity 
scrapped in all previous operations; otherwise, 1

Setup time remaining If time basis code C, standard run time minus elapsed 
time to date; otherwise, standard setup time minus 
actual time to date, factored for standard efficiency and 
standard setup crew size.

Runtime remaining If time basis code C, standard runtime minus elapsed 
time to date; otherwise, standard runtime minus actual 
time to date, factored for standard efficiency. 

Item ID If not a KBC configured item: Item number; if a KBC 
configured item: Item number plus a 7-position 
sequence number
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Purchase (PPIPUR)

For planned items, all open purchase order line items (POITEM and POBLKT), 
purchase requisitions, open intersite orders (XFRORD), and all firm planned orders 
for those order types from the Planned Order file (PLNORD)

AVP field ERP source
Item ID Item number
Order Type
R  Released order
P Firm planned order

If open purchase order from POITEM or POBLKT, 
purchase requisition from REQHDF, or open intersite 
order (IO) from XFRORD: R
If a firm planned order in PLNORD: P

Order ID If open POITEM: PO number
If open POBLKT: PO number and release from POBLKT
If purchase requisition: Requisition number
If open intersite order: IO number
If in PLNORD: the download process generates a 
unique order ID

Line number If open purchase order: line item sequence; otherwise, 1
Due Date If open purchase order, intersite order, or purchase 

requisition: Due date to stock
If in PLNORD: Due date (PODUD)

Order Quantity If open purchase order: order quantity plus deviation 
quantity minus the quantity received to stock
If purchase requisition: the order quantity
If an open intersite order: Order quantity minus the 
quantity received

Reschedule flag (0-5) For POITEM and POBLKT: Order reschedule code 
(ORRC in POITEM)
For REQHDF: 1 (no rescheduling). Not supported for 
requisitions
For XFRORD: 1 (no rescheduling). Not supported for 
intersite orders
For PLNORD: Order reschedule code (ORRC in 
PLNORD)

Vendor ID For purchase orders and requisitions: the vendor from 
the purchase order or requisition; otherwise, blank

Buyer ID For purchase orders and requisitions: the buyer from 
the purchase order or requisition; otherwise, blank
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Warehouse Control (PPIPLN)

AVP uses the MRP warehouse-level data. Most of this data is stored in either 
MRPCTL or PLNINF.

AVP field ERP source
Location ID Planning warehouse (PLWH)
Site ID Site for this warehouse (STID)
Current date MRP current date (plan as of this date {CUDT})
Release date Flag order for release if the order start date is on or 

before this date (RLDT)
Start date Horizon start date: the earliest date to use for planning 

(STDT)
Calendar end date The last workday in the 5-year calendar (CLNE)
Cancel Reschedule orders to be canceled to last month date if 

this code is 1 (CANC)
Last month date Calendar end date less one month. For use with Cancel 

(CLNM)
Reschedule frozen zone Warehouse rescheduling frozen zone (RSFZ)
Demands to track The number of demand records to create in order to 

track a supply (PEGC)
Track on hand Create demand records for on-hand if this code is 1 

(DSQH)
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Chapter  5.   Using the Advanced Planner engine

This chapter discusses the following information: 

Establishing calendars.............................................................................................. 5-1
Understanding AVP concepts ................................................................................... 5-4
Understanding the File menu ................................................................................... 5-6
Understanding the Display menu ............................................................................. 5-8
Using the toolbar .................................................................................................... 5-23

Establishing calendars

Typically, users create calendars two to three years out. If the default calendar does 
not exist, AVP forces you to create one when you load the project. Use the calendar to 
define separate calendars for each facility if required. Nonetheless, at least one 
default calendar must be used. AVP uses the default calendar to calculate purchase 
lead times. If you add any calendars, or make any changes to the default calendar, 
you must reload the project in order for the changes to take effect. 

The default calendar is the calendar under which most of your company works. All 
facilities are initially associated with the default calendar. To restore the your previous 
default working hours per day, click the Restore button. Then click Save. You cannot 
restore once you have changed the default working hours per day and saved it. 

To look at or edit the calendar, select DBMaint > Calendar. The warehouse for which 
the calendar was created appears. 

To create a calendar, do the following: 

1. Create the default calendar. All facilities are initially associated with this calendar. 

2. Make duplicates of the default calendar and modify as required. 
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3. Associate the facilities with the new calendar. 

New Calendar
Use this command to create new calendars. The software asks you set the 
duration for which the calendar is to be created. Note that when you create a new 
calendar, any holiday or maintenance schedules you previously created with 
default calendars have to be re-created for this calendar. 

Duplicate Calendar
Use this command to create another calendar by setting your default calendar as 
your starting point. By doing this, you can set your default calendar as your 
starting point. The hours per day, holiday, and work-week information are carried 
over from the default calendar. 

Associate
Use this command to associate workcenters with calendar you have already 
created. The list of facilities appears on the left. Select one or more facilities to be 
associated with this calendar. You can select multiple facilities by using the Shift 
or Control button. Select the calendar with which to associate these facilities from 
the right side of the window. Then click Associate. Exit the Associate dialog box. 
Save the calendar information to permanently save associations. 

Exit
Exits the calendar utility and returns you to the window from which you came.

Calendar Start Date
Click this button to reset the start date. 

Calendar End Date
Click this button to reset the end date. 

Default Working Hours Per Day
The number of working hours per day for this calendar. Reduce the time in order 
to account for breaks. Click on the Default button to populate the default hours 
per day for the calendar. 

Max Work OT
Not used with AVP. 

Start of Week
Not used with AVP. Determines the bucket start in the time-phased chart. 

Max Non-work OT
Not used with AVP. 

Working Days in Week
When you click the Default button, the default hours per day field is populated on 
this many days in each week. 

Max Weekly OT
Not used with AVP. 

To simulate days off and maintenance on new facilities, double-click the specific date 
in the calendar dialog box and enter the new number of hours of availability on that 
day. Type in zero if it is a day off. Click OK.

Establishing minimum buffer (queue) times

Minimum buffer (queue) times are used in the forward scheduling routines of AVP. 
While typical buffer (queue) times are downloaded from the standard queue time 
value for a facility, you must establish minimum queue times in the AVP engine. 
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Minimum queue times are typically set to aggressive values of queue time at the 
facilities. The lower the values of minimum queue times, the less the push out of 
independent orders. The default value of minimum queue time is zero. Minimum 
queue times are entered in seconds and are based on the default calendar. 

What to do
1. Select DBMaint > Facility. The SQL dialog box appears. 

2. Click OK. The WKCTR Table appears. Scroll until you see the 
MIN_BUFFER_TIME column. 

3. Type in the minimum queue time in seconds of the default calendar at that 
workcenter. You can compress some of the columns to the left of the 
MIN_BUFFER_TIME column in order to see the facility ID. 

To save the changes, move the focus to the next or previous row. 

4. Close the table. 

5. Load the project again in order for the changes to take effect. 
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Understanding AVP concepts

This section discusses the following Advanced Planner concepts: 

• Forecast consumption
• Maintaining decisions
• Control items
• Item process code
• Forward scheduling
• Order lead time
• Lot sizing policy

Forecast consumption

This window shows you consumption of all forecast records that are downloaded. 
Forecasts can be consumed by sales orders for that item or of its parent item based 
on how you have configured the forecast. You must maintain a list of items for which 
you want the forecast to represent the forecast for the entire demand stream of the 
item. 

By default, the forecast specified is consumed only by sales orders for that item. In 
addition to the forecast downloaded from XA, safety stock forecast records are 
generated for items for which safety stock is specified. Safety stock is not consumed; 
it serves as an additional requirement for the item. Safety stock requirements are 
placed at a fixed duration from the current date. See “Item (PPIPRT)” for more 
information.  

Forecast ID
A descriptive, non-unique identifier for the forecast record.

Part ID
The item being forecast.

Forecast Qty
The quantity being forecast for that item on that day. 

Qty On Order
The forecast in that month that are unconsumed by open orders in that month. 

Balance forecast
The unconsumed forecast (Forecast Qty - Qty on Order). 

Maintaining decisions

AVP maintains the stability of time phase L: C when decisions are being made. If this 
is not done the time phased L: C becomes too unstable to make useful decisions. 
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• If load is moved forward from one bucket to another then the item has to be 
declared a control item. In addition all planned supplies due earlier than this 
supply are firmed up. If this is not done the newly rescheduled supply is expedited 
in and additional planned supplies take its place.

• If the item is a control item and the load is moved backward (earlier) from one 
bucket to another, the supply order and other planned supplies for that item 
between the moved-to bucket and the moved-from bucket are set to reschedule 
code 5. The reschedule code for firm and released supply is not modified. 

• If the item is not a control item, the supplies within the two bucket ranges are 
firmed up and are set to a type 5 supply. This applies to all planned, firm, or 
released supply orders. 

To avoid seeing all exception conditions on the engine, the difference between the 
planned dates and the moved to date is stored as an offset for the work order. The 
user has the option to hide exceptions within offset.

Control items

Control items are those items with an item reschedule code of 1, 2, or 3, or master-
level or purchased items with an item reschedule code of 0. Manufactured and 
purchased items are treated the same way. AVP does not automatically re-schedule 
open and firm supply orders for control items. You, however, can manually intervene 
during the planning session to reschedule the orders. 

AVP deletes and recreates planned orders for control and non-control items each time 
it explodes through the bill of material. All open and firm planned orders for non-
control items are generally rescheduled during each explosion. The exceptions to this 
rule are as follows: 

• Open and firm planned orders are not rescheduled within the rescheduling frozen 
zone. 

• Open and firm planned orders are not rescheduled if the order reschedule code is 
5. 

You can identify additional control items during an AVP session. 

Item Processes

AVP fully supports EPDM item processes, allowing multiple valid item revisions on 
one date, and multiple item processes for each item revision. An item revision can 
have only one primary item process on one date. AVP also lets you control how many 
item processes and corresponding bills and routings are downloaded for planning. 
See Chapter 4, “Downloading data to the Planning Engine” on page 4-1 for more 
information.  

AVP determines the effective item process for planned work orders as follows: 

1. Find the item revision with the latest effective-from date less than or equal to the 
order start date

2. If multiple revisions with the same effective-from date exist, find the one with the 
latest effective-to date

3. Use the primary item process for the item revision effective on the order start 
date. 
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Forward scheduling

Forward scheduling ensures that reasonable dates are set for order due dates. 
Suggested due dates in the Supply Demand window and Orders window are set to 
these dates if the orders are past due. The earliest feasible date for a supply is 
calculated using minimum queue times and is affected by the following: 

• Horizon start
• Back wall due to firm order due dates
• Minimum lead time for purchase parts. 

Order lead time

Since routing and facility information is available, lead times are calculated rather than 
using fixed lead-time values. Order lead times are calculated using the facility queue 
information and setup and runtime information for an order. The lead time for an order 
is the sum of the typical queue times for the resources through which the orders 
passes and the processing time at the facilities along its route. AVP uses a transfer lot 
of 1 to calculate lead time. 

Lot sizing policies

AVP supports lot sizing policies for both make and purchase items. The quantity of 
planned supply is determined using the following parameters in the part table: 

• Aggregation period (in days)
• Purchase Multiple of (quantity)
• Minimum lot (quantity)
• Make Maximum Lot (quantity)

AVP generates a planned supply order on the date of the first shortage for all the 
requirements over the aggregation period. It then adjusts this quantity by the minimum 
lot if the supply quantity is less than the minimum lot and the purchase multiple-of, by 
rounding the quantity up to the nearest multiple. For manufactured items, AVP plans 
orders no larger than Make Maximum Lot, if one is specified. 

Understanding the File menu

The following sub-menus are available from the File menu: 

• System Configuration. 
• Load project. 
• Save Plan. 
• Cancel Plan. 
• Export Data ...
• Print. 
• Print Preview.
• Print Setup ...
• Exit Application. 

System configuration

See “Configuring AVP” for more information.  See “Planning multiple warehouses” for 
more information.  
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Load project

You can load the data by selecting File > Load project or by clicking on the file-folder 
icon. The following window appears: 

Advanced Planner reads all the data and loads it into memory. It also does the 
following:

• Builds the product structure network using the BOM and Routing information
• Processes the workorder files
• Does forecast consumption.

Once the data is loaded into memory, you can access available charts and tables 
either from the Display menu or by right-clicking your mouse in the window. Available 
decisions are available by right clicking in the window. Most decisions are available 
only for supply orders, and you need to select one or more orders by selecting any 
column in that order’s row. Only decisions that can be made for that order are shown. 
Other decisions are grayed out.

Save Plan

See Chapter 6, “Uploading data to the System i” on page 6-1 for more information.  

Cancel Plan

See Chapter 6, “Uploading data to the System i” on page 6-1 for more information.  

Export Data ...

Select this menu item to export information that appears in table format to a text file. 
To switch from the chart format (default) to the table format, select Display > Table. 
Then load the chart again. The Windows Save As window appears. Select the 
directory in which you wish to save the text file, and then name the file appropriately. 

Print

Select this menu item to print the active window. 
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Print Preview

This menu item appears only if the Time-Phased Order Chart is active. Select this 
menu item to see a preview of the Time-Phased Order Chart. Use this printout to see 
cumulative load, cumlative capacity, and capacity information. 

When you select this option, a preview the chart you select appears as it will on a 
standard sheet of paper. From this preview window, you can zoom in or out, and 
select to print the chart. When you select Print ..., the Windows Print window 
appears. If you are using extended horizons, you can preview and print the Time-
Phased Orders chart in a two-page format. 

Print Setup ...

This menu item appears only if the Time-Phased Order Chart is active. Select this 
menu item to select the bucket range of the Time-Phased Order Chart you wish to 
print. The following dialog box appears: 

Type in the starting and ending buckets. 

Exit Application

See Chapter 6, “Uploading data to the System i” on page 6-1 for more information.  

Understanding the Display menu

The following functions are available from the Display menu: 

• Toolbar. You can select the Standard toolbar with this function. 
• Bar. You can see the succeeding windows as bar charts. 
• Table. You can see the succeeding windows as tables. 
• Item List Filter. See “Item List Filter” for more information.  
• Create Firm Planned Order, 
• Item List. See “Item List Filter” for more information.  
• L:C for Plant. See “L:C chart” for more information.  
• Items Load. See “Items Load” for more information.  
• Time Phased. See “Time Phased L:C” for more information.  
• Orders Window. See “Orders Window” for more information.  
• Supply Demand for Part. See “Supply Demand for Item” for more information.  
• Waterfall—Pegged Order. See “Waterfall charts” for more information.  
• Waterfall—Feeding Supplies. See “Waterfall charts” for more information.  
• View Log. See “View Log” for more information.  
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• Undo. See “Undo” for more information.  



Contents Index Page 5-10
 Using the Advanced Planner engine

L:C chart

Use this chart to see the load to capacity percentages for the facilities in the plant. The 
chart is sorted in the descending order of the load to capacity. It shows you facilities 
that are potentially overloaded and imbalances you must resolve. 

The bar chart is color coded as follows:

• If the load is greater than the capacity over the planning horizon, the bar is red

• If not red and if the cumulative capacity is less than the cumulative load up to any 
bucket, the bar is yellow. For example: 

- If the bar is not red or yellow and load is greater than the capacity in at least 
one bucket, the bar is blue.

- If the bar is not red, yellow or blue, the bars is green.

You can specify setup percentage as a percentage of the total load in the Workcenter 
table. 

Decisions

Set Telescopic buckets. You can the bucket size and the number of buckets using a 
dialog box. See “Using the toolbar” for more information.  

Drill Downs
• Items Load
• Orders Window
• Time Phased L:C. 
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Items Load

Use this chart to see the load in hours contributed by each item to the overall load of 
the facility in a bucket. You can also see the quantity each item is short. The Percent 
column shows the percentage of the total load contributed by each item

When you reach this window from a specific bucket rather than an entire horizon, you 
see the information for that specific bucket. 

Decisions

Identify as Control Item. 

Drill downs
• Orders Window: Filter is workcenter and part

• Supply Demand for Item: Filter is Part ID
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Orders Window

Use the Orders window to see information dependent upon from where you reached 
this window. You can get to this window from the following: 

• L: C for plant
• Time phased L: C
• Items Load
• Specific Item List Filter. 

Order Type
One of the following: 

Customer
Forecast
Safety Stock
Mfg-Released 
Mfg - Firm
Mfg - Planned
Purchase - Released
Purchase - Firm
Purchase - Planned

Order ID
The workorder ID for released manufacturing orders; the purchase order ID for 
released purchase orders; the order ID for independent orders. 

Item ID

Item Type
One of the following:

Control - Mfg
Non-Control mfg
Control - Purchase
Non-control purchase

Due Date
The current due date of the order. 

Suggested Date
The requirement date for supply orders and suggested due date, assuming firm 
supply for independent demand. If the suggested date is the maximum date, blue 
appears for supply order. The default (white) appears for demand orders. If the 
suggested date is less than the order due date, red apperas for supply orders and 
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yellow appears for demand ordres. If the suggested date is greater than the order 
due date, yellow appears for supply orders and red appears for demand orders. 
Note that the red and yellow conditions are reversed for supply and demand 
orders. 

Source
The parent workorder ID that causes the greatest exception for this supply, or, if 
this supply feeds independent demand, the Demand order ID. 

Source Item
The item ID associated with supply in the Source column. If you are seeing supply 
at a lower level, this field contains the Part ID of the parent item that drives this 
supply. For independent orders, the same value as the item ID field. 

Analyst/Buyer ID
The analyst or planner for the part if it is a make part. If it is a purchase part, the 
buyer for this part. 

Customer/Vendor
If this is an independent customer order, the customer from the order was 
received. If this is a purchase order, the vendor who has the purchase order. 

Load
Information in this field appears only if you reached this display from the load to 
capacity chart. 

Load %
Information in this field appears only if you reached this display from the load to 
capacity chart. 

Legend
Indicates that the row is expedited, deferred, or cancelled, based on the color 
coding. 

Decisions
• Alternate Route Order: Available only for firm or planned orders that have 

alternate routes defined in EPDM

• Offload: Change the workcenter for one operation. Available only for released 
orders since there are no specific routes for firm or planned orders

• Outsource: Change the work order from a make route to a purchase route

• Re-Schedule Supply: Available only for control items. The due date of the supply 
is rescheduled to the earliest required date of the supply. 

• Modify Supply: Modify the due date and process for an existing firm supply. 
Planned supplies are firmed up in the process. If you modify a planned or firm 
supplies date, you can also modify the quantity and the re-schedule code. If you 
modify a released supply, you can only modify the due date and re-schedule 
code. 

• Level Load: Change the due date of the supply within same work center.

• Re-Schedule Requirement: Available from all released and firm planned supplies 
for control items. You can reschedule the due date of the parent item supplies and 
their parents. Forward scheduling is baed on minimum queue times on facilities 
and not on typical queue times. 

• Re-Schedule All Requirements: Reset all requirement dates based on due date of 
all the supplies in this window.
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• Identify Control items: You can identify additional control items during the 
planning session. Your decisions are saved back to XA and are downloaded the 
next time. 

Drill Downs
• Waterfall: For a specific supply order or a specific demand order

• Supply Demand for Item: For the item associated with the supply or demand 
order.

Time Phased L:C

Use the time phased L:C chart to see the bucket L: C in user-defined buckets. 

You can determine the L: C and imbalances that need to be addressed from this 
screen. You can preview a printout of the timephased orders chart for extended 
horizons, and then print this preview. When you select to print the window, a dialog 
box lets you specify the bucket print range. Buckets with excessive load will cause the 
hours information on the left side of the printout to merge together. 

The due date of the supplies determine the bucket in which they generate the load. 

The maximum lot size has an impact on time-phased load calculations. For example, 
you have a demand of 190 pieces. The maximum lot size is 25. SCM splits the 
demand into 8 small demands with same due date which generate 8 almost identical 
tasks on the workcenter. These demands have the same schedule start and end 
dates (except the final one) which causes an overload. 
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Decisions
• Alternate Route Order: Available only for firm or planned orders that have 

alternate routes defined in EPDM

• Offload: Change the workcenter for one operation. Available only for released 
orders since there are no specific routes for firm or planned orders

• Outsource: Change the work order from a make route to a purchase route

• Re-Schedule Supply: Available only for control items. The due date of the supply 
is rescheduled to the earliest required date of the supply. 

• Modify Supply: Modify the due date and process for an existing firm supply. 
Planned supplies are firmed up in the process. If you modify a planned or firm 
supplies date, you can also modify the quantity and the re-schedule code. If you 
modify a released supply, you can only modify the due date and re-schedule 
code. 

• Level Load: Change the due date of the supply within same work center.

• Re-Schedule Requirement: Available from all released and firm planned supplies 
for control items. You can reschedule the due date of the parent item supplies and 
their parents. Forward scheduling is baed on minimum queue times on facilities 
and not on typical queue times. 

• Identify Control items: You can identify additional control items during the 
planning session. Your decisions are saved back to XA and are downloaded the 
next time. 

Drill Downs
• Waterfall: For a specific supply order or a specific demand order

• Supply Demand for Item: For the item associated with the supply or demand 
order.

• Orders Window: If the time-phased L:C appears as a table, you can see the 
orders for a specific bucket. 
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Supply Demand for Item

Use this window to see the pegging information between supply orders and demand 
orders for an item. It shows one level pegging between and item and its immediate 
parents. 

Supply ID
One of the following: 

The workorder ID for released orders
The purchase order ID if the route is a purchase route
Firm if it is firm planned order
Plnd if it is a planned order. 

Qty
The quantity of the supply order remaining or pending.

Start Date
The current start date associated with the workorder. For PO orders this field is 
set equal to end date. 

Due Date
The current due date of the supply. If you re-scheduled the order, this date is set 
equal to the suggested due date. For PO routes, the dock date

Load
Appears only when you reach this window from the load to capacity chart. The 
load placed by this supply in the bucket being drilled down.

Load %
The percentage of load in the bucket generated by this supply.

Suggested Due Date
The recommended due date of the supply to meet shortages in supply. Also, 
excess supply

Projected On Hand
The supply on hand + quantity on release or firm supply up to bucket date. The 
required quantity up to bucket date. Supply availability is calculated based on the 
due date, not the suggested due date.
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Required Date
The due date of the requirement.

Required Quantity
The quantity pegged to a specific requirement.

Peg To
The order ID of the independent demand if this item has an independent demand. 
If this is a customer order, a combination of the Order ID field and the Line 
number field in the Sales table. If the item is lower in the BOM and this supply 
feeds into a firm order or released order of a higher-level item, that information 
appears here. If the supply feeds into a planned order, the word Planned appears 
here.

Item
The item driving the requirement

Analyst/Customer ID
The customer ID for the sales order or forecast order, if available. Or, the Planner 
ID of the item this supply feeds into.

Due Date
The current due date of the independent order if the supply feeds into an 
independent order. Or, the start date of the planned, firm, or released workorder 
this supply feeds into.

Suggested Due Date
The recommended due date of the independent order or supply this order feeds 
into based on shortages for this item. An earlier due date is not suggested if the 
supply is available earlier than the required date; the suggested due date is set 
equal to the due date.

Decisions
• Alternate Route Order: Available only for firm or planned orders that have 

alternate routes defined in EPDM

• Offload: Change the workcenter for one operation. Available only for released 
orders since there are no specific routes for firm or planned orders

• Outsource: Change the work order from a make route to a purchase route

• Re-Schedule Supply: Change the due date to a suggested to due date for this 
supply. 

• Modify Supply: Modify the due date and process for an existing firm supply. 
Planned supplies are firmed up in the process.

• Level Load: Change the due date of the supply within same work center.

• Re-Schedule Requirement: Reset requirement dates based on the due date of 
supply

• Re-Schedule All Requirements: Reset all requirement dates based on due date of 
all the supplies in this window.

Drill Downs
• Waterfall - Pegged Orders
• Waterfall – Feeding Supplies
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Waterfall charts

Two types of waterfall charts are available: 

• Pegged Orders shows the level-by-level pegging between a supply order and its 
parent orders all the way to the independent demand. 

• Feeding Supplies shows the component shortages for a specific supply and the 
supplies available to satisfy them. 

For each item, you can see the gross quantity, the quantity on hand, and the quantity 
short. You can also see the planned and firm supply available to satisfy the 
requirements. 

Interstate symbol with W
Released workorder

Interstate symbol with PL
Planned workorder

Interstate symbol with F
Firm planned order

Screw
Item level information. Red indicates control items.

Truck
Released purchase order.

B
Planned purchase order. 

Figure 5-1.  Waterfall—Pegged orders  

Figure 5-2.  Waterfall—Feeding Supplies  
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Item List Filter

Use this tool to see the status of your critical parts right away. You can filter critical 
items based on either supply or independent orders. You can save multiple templates 
to the database. These templates are loaded and appear when you select Display > 
Item List. 

A quick way to view supply demand for an item is select a specific item from the item 
drop down list in this window

The item list filter window consists of four distinct sections: 

• Template name
• Item properties. 
• Supply Orders
• Demand orders. 

Template name

Once you have determined your search information, you can it by typing in a name 
(for example, Purchase Exceptions) and click Save. To use a saved template, select 
Display > Item List. To use a particular template as a starting point for another 
template for a new type of search, select the template, make your changes, and then 
click Save As.

Item properties
Item ID

A combo box from which you can select a specific item. 



Contents Index Page 5-20
 Using the Advanced Planner engine

Make Items
Select Y (default) or N. If you select yes, make items appear; otherwise, they do 
not appear. 

Purchase Items
Select N (default) or Y. If you select yes, purchase items appear; otherwise, they 
do not appear.

Planner ID/Buyer ID
A combo box from which you select an Analyst ID. The default is ALL. If you 
select purchase items, this is a list of buyer IDs. If you select make items, this is a 
list of Analyst IDs. If you select both, this is a list of both with duplicates 
eliminated. 

Control Items
Select Y, N, or Ignore (default). If you select yes, only control items (items with a 
reschedule flag of 1, 2, or 3 in the Item table) appear. If you select no, only non-
control items appear. If you select Ignore, items are selected regardless of control 
code. 

Supply Orders
Show past due > (0 and any positive whole number)

If you select supply orders, only those items with a start date greater than the 
number of days before the horizon start that you select here appears. If you select 
demand orders, those items with a due date in the past of more than the number 
of days that you select here appears. 

Show Expedites > (0 and any positive whole number)
Available only for supply orders. Only those items with a supply due date more 
than the number of days you select here later than the required date appear. 

Show Items with Defers > (0 and any positive whole number)
Available only for supply orders. Those items with a supply due date earlier than 
the number of days you select here than the required date are added to the list of 
items if not already there. 

Show Items with Cancel Orders
Select Y (default) or N. Available only for supply orders. If you select Y, items with 
orders recommended for cancellation are added to the list of items if they are not 
already on the list. If you select N, items are added to the list regardless of the 
presence or absence of cancel orders. 

Show Items with exceptions within Offset
Select Y (default) or N. Available only for supply orders. Offset is the number of 
days a supply is moved in or out in order to balance load to capacity. This often 
creates an exception condition, if the order due date no longer matches its 
required date. To avoid seeing these messages on the engine during planning, 
select N. Items then are added to the item list only if defer or expedite exceptions 
are greater than the offset value. If you select Y, item deferrals and expedite 
exceptions are added to the list, even if their exceptions are less than the offset 
value. 

Show Items with planned orders within Frozen Zone
Select Y (default) or N. Available only for supply orders. If you select Y, items with 
planned orders within the period are added to the list of items if they are not 
already there. If you select N, items are added to the list without checking for 
planned orders within the frozen period. 
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Demand orders
Customer Orders > X (any positive whole number)

Available only for demand orders. Only those items with customer orders with 
projected completion more than the number of days you select here than the due 
date appear. 

Forecast Orders > (any positive whole number)
Available only for demand orders. Only those items with forecast orders with 
projected completion more than the number of days you select here than the due 
date appear. 

Safety Stock Orders > (any positive whole number)
Available only for demand orders. Only those items with safety stock orders with 
projected completion more than the number of days you select here than the due 
date appear. 

Show past due > (0 and any positive whole number)
If you select supply orders, only those items with a start date greater than the 
number of days you select here before the horizon start appear. If you select 
demand orders, items with a due date in the past more than the number of days 
you select here appear. 

Buttons

The following buttons are available from this window: 
OK

Save template changes to memory, but not to the database. 

Cancel
Do not save anything and exit the Item List Filter. 

Save
Save changes to the template to the memory and to the database. 

Save As
Save this new template to the memory and the database with a user-defined 
template name. 

Delete
Delete the current template from the database, effective the next session. The 
template is not deleted from memory as some windows are still using the 
template. 

Examples

To see purchase parts for control items with orders more than 3 days past due or 
cancel orders, complete the window as follows: 
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To see items with customer orders that are late by more than 3 days, but not those 
items with safety stock or customer orders, complete the window as follows: 
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View Log

Use this function to save the decisions made in the planning session. You can view 
and print the log of your decisions. 

Undo

You can undo most of your decisions; however, you cannot undo change 
requirements and change all requirements decisions. To undo those decisions, load 
the project again. See “Load project” for more information.  

Using the toolbar

The following functions are available from the AVP toolbar: 

• Load project. Use this icon to load the project into memory. 

• Print screen in focus. Use this icon to print the active window. 

• Refresh current view (only). Use this icon to refresh the active window. 

• Refresh all AVP views. Use this icon to refresh all AVP views. Use this after using 
the Undo function. 
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• Alternate Route. Use this icon only for planned and firm planned supplies with 
multiple processes defined in EPDM. 

The following window appears when you select this icon:

You can type in the due date of the supply. The available alternate processes 
appear. You then set the reschedule code for the supply. If a planned supply is 
alternate routed, the supply is firmed up. this information is uploaded to the 
System i and downloaded for the next planning session. 
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• Offload. Use this icon to perform offload decisions on released work orders only. 
Alternate facilities defined in the route appear at the top of the alternate facilities 
list. If the reschedule code is set to 5, you cannot modify the due date. 

The following window appears when you select this icon: 

• Outsource. Use this icon to create a purchase supply for a make item. The item ID 
is the part that will be outsourced. 

The following window appears when you select this icon: 

Quantity
Type in the quantity to be outsourced. 

Date
Type in the day on which the material will be available in the dock. 
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Reschedule Code
Either 5 or other. If you set this code to 5, earlier requirements for this item are 
satisfied by generating planned manufacturing orders. Any other value 
reschedule behavior is based on the control item code for the item. 

• Level load. Use this icon to move loads from one bucket to another on the same 
facility. 

The following window appears when you select this icon: 

You can move the load from one bucket to another in the same facility. See 
“Maintaining decisions” for more information.  
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• Telescopic buckets. Use this icon to define a smaller planning window up front 
and longer planning window in the future. The default is weekly buckets. You type 
in the number of buckets for each bucket duration. 

The following window appears when you select this icon.

You can type in the number of buckets for each bucket duration. 
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Chapter  6.   Uploading data to the System i

As discussed in Chapter 4. “Downloading data to the Planning Engine“, you can plan 
in two modes: test or planning. The planning mode is set when you start the engine, 
from the DownLoad option used in the last download. 

When you finish planning in test mode, select File > Exit Application to exit the 
planning engine, the only available option. 

When you finish planning in planning mode, you have three options: 

1. Select File > Save Plan to save the plan, upload the data to theSystem i, and 
release the System i jobs locked when you ran download. This is the normal 
choice. The remainder of this chapter describes what happens when you take this 
option. 

2. Select File > Cancel Plan to release the locked System i jobs without saving the 
plan. Use this option if you don’t want to save the plan until you make changes of 
some sort to data on the System i. After you make the changes, run download 
and then plan again. 

3. Select File > Exit Application to exit the planning engine without either saving the 
plan or releasing the locked System i jobs. You must confirm your action if you 
select this option, as this is not a normal choice. Use this option only if you need 
to exit the planning engine for some reason but do not want to save or cancel the 
plan. 

When you save the plan, the appropriate data is transferred to the System i and 
processed as described. You can optionally update either or both of the following 
dates in customer orders from the plan by selecting options before you run download. 

• The current promised (delivery) date
• The current manufacturing due (ship) date. 

AVP uses the manufacturing due date in customer orders as the required date in 
planning, just as MRP does. If you decide during planning that you cannot meet all the 
customer order dates and move one or more of them, you can update the current 
manufacturing due (ship) dates you believe you can meet and the current promise 
(delivery) dates. The promise dates are updated to the manufacturing due (ship) date 
plus the shipment lead time. Only if you update the current manufacturing due date 
will the changed date be used as the required date in the next planning run. 

What to do ................................................................................................................ 6-2
What AVP does ........................................................................................................ 6-3
Uploaded data .......................................................................................................... 6-4
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What to do

Edit the APDataLink.ini file to specify whether you want to update either of the dates 
in the Customer Order file. 

COMPromiseDate One of the following: 

0 Do not update the promise date

1 Update the promise date only the first time it 
changes

2 Upload the promise date every time it changes

COMDueDate One of the following: 

0 Do not update the manufacturing due date

1 Update the manufacturing due date only the first time 
it changes 

2 Update the manufacturing due date every time it 
changes.

[ODBC]
DataSourceName=AP60
UserId=SCM
Password=SCM
[Download]
Env=66
Warehouse=TP6
DownLoad=0
LoadItem=0
PrintReport=1
Hours=0000008
[Upload]
COMPromiseDate=0
COMDueDate=0
[Download Files]
InputFileDir=C:\MAPICSADVPLAN\SampleDBAP\
CommaSeparated=0
ShowColumnHeader=0
Delimiter=
[Debug]
DebugDesign=0
DebugUpload=0
[System]
AVPActive=0
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What AVP does

Uploading to the System i performs the following on the System i: 

1. Loads the following plan information into these MRP planning work files: 

• Requirements. Both: 

- Unconsumed forecasts (Source-RQSOR=6 and Origination-RQORG=6) 

- Generated component demand (Source-RQSOR=8).

• Planned Order. All supply orders, including open, firm planned, and planned. 

• Demand Reference. Demand information as specified in the MRP Planning 
Run Execution options.

• Reschedule Activity. Rescheduling actions automatically taken by the engine 
or by a user interacting with the engine during planning. 

2. Reschedules open manufacturing orders, REP (Repetitive Production 
Scheduling) schedules, and purchase orders rescheduled in planning from the 
information in the Reschedule Activity file. 

3. Updates the current promise dates and current manufacturing due dates in 
customer order line-item releases, as specified in the upload options. 

4. Updates the actual workcenter field in the manufacturing order operation when a 
user offloads an unstarted operation in a manufacturing order to an alternate 
facility. This captures the action in the execution database. 

5. Creates an unreleased REP schedule to capture the alternate production line and 
changes the planned order record when a user offloads a planned or firm planned 
REP schedule to an alternate production line. This captures the offloading action. 

6. Updates the production line in the unreleased REP schedule when a user offloads 
an unreleased REP schedule to an alternate production line. This captures the 
offloading action. 

7. Updates the item reschedule code to 1 (no automatic rescheduling) when a user 
flags an item as a control item. 

8. Runs the closing steps in the MRP planning run in order to: 

• Load the MRP planning work files to the MRP planning files

• Create the Order Review file for use in MRP/OBPM review and release of 
manufacturing, purchase, and intersite orders

• Print the MRP reports as specified in the MRP Planning Run Report options. 
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Uploaded data

The following files are uploaded from the AVP engine to the System i. The files are 
written to the SampleDBAP folder in the AVP install folder, then transferred to the 
System i for processing. In the SampleDBAP folder, the files have a file name (the first 
word in in parentheses in the following list) plus a file extension of .out. On the System 
i, upload loads the first four files into the MRP planning work files, and then to the 
MRP planning files. Upload processes each file as described. 
Requirements (REQMTS)

Upload writes to kinds of records to this MRP file: 

• Component demand for planned and firm planned orders generated by the 
engine during planning

• Unconsumed forecasts generated during forecast consumption. See 
“Forecast consumption” for more information.  

Planned orders (PLNORD)
Upload writes all the records in this MRP file. If EPDM is active, and an 
unreleased REP schedule was offloaded to another production line during 
planning, upload updates the item process and production line information in 
MOMAST from the PLNORD record. If EPDM is active and a firm planned order 
for a REP schedule was offloaded to another production line during planning, 
upload creates an unreleased REP schedule using the item process from the 
PLNORD record and changes the PLNORD record to reflect the unreleased 
schedule. 

Demand reference (DMDREF)
If specified in MRP Planning Run Execution Options, the planning engine 
provides information for tracking supply to five kinds of demand:

Sales
Unconsumed forecast
Safety stock
Supply order
Negative on hand

Upload incorporates this information into the MRP file. 

Reschedule activity work (RACWRK)
Upload writes a record for each open and firm planned order for: 

• A controlled item that the user interactively rescheduled during planning

• An uncontrolled item that the engine either rescheduled or tried to reschedule 
because the order is needed earlier or later than its due date or is not needed 
at all. Upload on the System i reschedules the open orders rescheduled 
during planning. 

Customer order update (CUSORD and PPCOWK)
Upload writes a record to this file only if the user interactively rescheduled a 
customer order during planning. Upload on the System i reschedules the dates in 
the customer order line item release if COM is installed as specified in the upload 
options. The records remain in the PPCOWK file on the iSeries until the next 
upload for processing by the user if COM is not installed. 

Manufacturing routing (MFGRTG)
Upload writes a record to this file only if the user interactively offloaded a 
workorder step (manufacturing order or REP schedule operation) to another work 
center. If the step is a manufacturing order operation, upload on the System i 
updates the actual facility (AWRKC) in the operation record (MOROUT). If PDM is 
active and the step is for an unreleased REP schedule, upload updates the 
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production line (PLINE) in MOMAST. If PDM is active and the step is for a firm 
planned order for a REP schedule, upload creates an unreleased REP schedule 
for the production line (PLINE) and changes the PLNORD record to reflect the 
unreleased schedule. 

Control items (CTRLITM)
Upload writes a record to this file when an item is identified as a control item 
during planning. Upload on the System i updates the item reschedule code (ITRC 
in ITMPLN) to a 1 (no automatic rescheduling). 
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Appendix  A.   Download error messages

• Items

• Bills of materials

• Routings

Error number Error text
AMM0104 (W) Safety stock quantity was sent with a loss of data

Error 
number Error text Comments
AMM0111 (E) Calculated quantity per must be 

greater than zero. 
This component record is 
not downloaded.

AMM0112 (W) Calculated quantity per was sent 
with a loss of data.

AMM0113 (E) Operation sequence contains non-
numeric characters. 

The Planning Engine only 
works with numeric 
operation sequence 
numbers as noted below 
in Routings.

AMM0114 (W) Operation where used is not found 
in the routing file.

AMM0115 (E) Component bill of material is not 
referenced in a parent bill of material. 

Refers to KBC items.

Error 
number Error text Comments
AMM0116 (E) Production facility is not found.
AMM0113 (E) Operation sequence contains non-

numeric characters. 
The Planning Engine only 
works with numeric 
operation sequence 
numbers. This operation 
was not downloaded.

AMM0117 (E) Routing parent number is not found 
in the bill of material. 

Refers to KBC items.

AMM0121 (E) No routing was sent for item 
******************** because no item line 
exists for primary production line *****. 

With PDM active, an item 
line is required to send a 
routing. 

AMM0122 (E) A primary item process for item 
******************** was not sent 
because no item line record exists for 
it.

With EPDM active, an 
item line is required to 
send an item process. 
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• Production Facilities

• Inventories

• Manufacturing orders

Error 
number Error text Comments
AMM0100 (I) Maximum capacity is zero. Maximum utilization was set to 

95%. 
AMM0101 (W) Overtime rate was sent with a 

loss of data
AMM0102 (I) Maximum capacity exceeds 

100%. 
Maximum utilization was set to 
100%. 

Error number Error text
AMM0103 (W) On-hand quantity was sent with a loss of data. 

Error 
number Error text Comments
AMM0109 (W) Sequence number was sent 

with a loss of data.
AMM0113 (E) Operation sequence contains 

non-numeric characters. 
The Planning Engine only 
works with numeric operation 
sequence numbers. This 
operation was not 
downloaded.

AMM0110 (E) Item line record does not exist 
or needs review. 

The REP record for the Item/
Line relationship needs 
review. 
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Appendix  B.   Frequently asked questions

1. How do I determine the version of the Advanced Planner engine? 

a. Open Windows Explorer and select the AVP install folder. 

b. Right click on the advplanner.exe file. If you are unable to see this file, select 
View > Option and ensure that you can see all file types. 

c. Select the version tab. You will see the version number. 

2. What is the command to run AVP engine in the batch mode? 

Resonance -rap -s
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Glossary

alternate routing.  A set of bill of materials and routing data that captures another 
method for producing a product. 

ASCII (American Standard Code for Information Interchange). A binary 
character code used to represent a character in a computer. It consists of 128 seven-
bit codes for upper- and lowercase letters, numbers, punctuation, and special 
communication-control characters. 

batch. A quantity scheduled to be produced together. 

batch production. A manufacturing method used when the lot size of identical 
parts is produced in a factory. Batch production is the method adopted when the 
required product volumes are not adequate to permit continuous product of one 
product on dedicated machines.

bill of materials (BOM). A listing of all the subassemblies, parts, and raw materials 
that go into a parent assembly.

BOM. Bill of materials. 

bucket. A time period, usually daily, weekly, or monthly. 

bucketized load. The load within a given period of time. 

buffer. Additional planned lead time used to protect the system from the disruptions 
inherent in any process, or additional inventory used to enable filling customer 
orders in less than the normal lead time (stock buffer). A duration of time used to 
protect firm schedules generated during the planning process. Strategically placed 
before drums, shipping operations, or some assembly operations. 

burden rate. A cost, usually in dollars per hour, normally added to the cost of every 
standard production hour to cover overhead expenses. 

capacity. Time available at a resource over a period of time. Usually determined by 
how the resource is staffed. For example, capacity at machine A is 40 hours per 
week.

CGS. Cost of goods sold. 

child part. A manufactured component or purchase part used in assembly. A part 
made up of parts that have been made previously (parent parts).

classifying materials. A way of distinguishing orders of importance of materials in 
a plant. See “ignore materials,” “normal materials,” and “priority materials.”

configuration. The arrangement of components specified to produce an assembly.

cycle time. The time between completion of two discrete units of production. See 
“manufacturing cycle time” and “order lead time.” 

data file. A collection of related data records organized in a specific manner. 
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DBUtil. An AVP product that converts data files from any external source into a 
database that has the correct information and structure for AVP.

delivery lead time. The time difference between when a customer places an order 
and when the order is shipped. 

demand. A requirement for a particular product or component over time. 
Expressed by date, quantity, and product. 

dependency. Certain operations or activities cannot take place until certain other 
operations or activities have been completed.

dock-to-stock lead time. The time difference between the time a purchase part 
product arrives at the dock to when the part can be released. 

expedited POs (purchase orders). Purchase orders with a due date (arrival date) 
after the date of requirement on the shop floor.

first day load (FDL). A task must performed on the horizon start date and 
insufficient capacity is available. 

forecast. A planning methodology that predicts orders for a product. 

idle time. Time not used to perform a setup or process (run) material import. 

ignore materials. Materials completely ignored by a AVP for material analysis. For 
example, screws and bolts.

ignore workcenters. Workcenters sufficiently flexible to handle the load or with 
inaccurate data. You can specify to ignore these. 

inventory. Amount of money tied up in materials that the company intends to sell. 
Inventory is equal to the purchased material value of raw material, purchased parts, 
work in process and finished goods. 

jobs in progress (JIP). Operations or setups currently in progress on a 
workcenter, usually a drum. Used by AVP to account for significant progress on 
operations that might otherwise be scheduled for a full run. For example, a furnace 
operation that is 14 days long might be in day 12 by the time a scheduling session 
occurs.

L:C chart. A software function that shows load versus capacity information on all 
workcenters sufficiently flexible. To facilitate decision making, several display options 
appropriate for finite scheduling are available. 

manual overtime allocation. Allocation of exact amount of overtime on specific 
days. AVP reschedules the work center to optimize the schedule of the work center 
after OT allocation. AVP allocates overtime for every calendar day (not just every 
work day) in the range subject to a maximum of 24 work hours per day.

manufacturing cycle time. The difference between material release for an order 
and shipment of the release. 

minimum lead time.  Any of the following: 
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• Firm purchase orders due before today’s date plus a minimum lead time beyond 
which an order cannot be expedited

• Any firm purchase orders due outside of today’s date plus a minimum lead time 
that can be expedited to today plus a minimum lead time

• New purchase orders that can be made due today plus a minimum lead time. 

normal materials. All materials other than priority. Unless you ask AVP to analyze 
Priority Materials only, these materials will show up in your analysis. 

ODBC. Open Database Connectivity. 

offload. A decision you make during planning to change the workcenter for 
unstarted operations in a released order. 

offloaded jobs. Tasks that have been offloaded from their original work center to 
an alternate work center.

outside processing. A specific routing step always sent outside the plant for 
processing.

outsourcing. Buying parts which could be made in-house. Indicated in AVP by 
adding a purchase order to the Purchase file. If out sourced parts arrive on different 
dates, add multiple entries to the purchase file. AVP computes the date on which a 
requirement exists for an out sourced parts. It uses the arriving out sourced part for 
all orders that require the part after the date on which the part arrives. If insufficient 
parts arrive by the required dates, AVP plans to make the parts in-house. AVP 
assumes that all sub-components required for the out sourced parts have either 
been shipped or provided by the vendor. No requirements are generated for the 
quantity that has been out sourced. 

overhead $ (dollars). Operating expenses minus direct labor dollars. 

overtime (OT). Hours worked exceeding normal labor hours.

parent part. A part produced from one or more components. 

planned overtime. Shows by work center the overtime allocated in the current 
session

planned work orders. Work orders for parts to be released no sooner than the 
start date but as soon as possible after start date.

PO_Qty_Open. A field in the Purchase file that specifies the sum of all purchase 
order quantities for the same item due on the same date.

priority materials. Materials that may be hard to procure or have long lead times. 

product mix. The proportion of individual products that make up the total 
production or sales volume.

R&D (Research and Development) order. An experimental order. 

real time. The immediate availability of data to an information system as a 
transaction or event occurs.
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scheduling horizon. The time period for which scheduling is relevant.

setup. A procedure performed on a workcenter or workcenters to prepare for 
processing a given job.

setup time. The amount of time required to perform a setup. 

SQL. Structured Query Language. 

supply chain management. The use of information technology to give automated 
intelligence to a network of vendors, suppliers, manufacturers, distributors, retailers, 
and a host of other trading partners. The goal is for each player in the supply chain to 
conduct business with the latest and best information from everyone else in the 
chain, guiding supply and demand into a more perfect balance. Effective 
management of the supply chain enables a company to move product from the point 
of origin to that of consumption in the least amount of time at the smallest cost.

time-phased load profile. A chart that shows the orders at a workcenter. 

UDAs. User-defined attributes. 

undo. Reversal of decisions you made previously in planning. 

workcenter. A specific production area consisting of one or more people and/or 
machines with identical capabilities that can be considered as one unit for purposes 
of capacity planning and scheduling.

workcenter family. A group of similar work centers. AVP can show loads and 
capacities for work centers with specified families.

workcenter load profile. A chart that presents load to capacity ratios for the 
scheduling horizon established when AVP was started. The top portion of the chart 
provides details about the workcenter (for example, number of units, ID of the 
calendar associated with the work center, and the work center family).
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